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The Job Costing module is an additional function set that can be added to the MYOB Exo 
Business system. It is an external program that interfaces with the Exo Business core program. 

Job Costing provides a fully integrated solution for businesses using time costing and billing, 
businesses who have a high proportion of direct purchases relating to a specific client s project, 
and any other business that accumulates charges over a period of time. 

Invoicing is made easy. As each job progresses, activities associated with the job are recorded, for 
example labour or parts. These accumulated transactions can be manipulated and formatted to a 
high degree in order to present an invoice in a view suitable for the customer, while retaining a 
true picture of cost and profitability at a detailed level. 

Standard job information options (categories etc.) are set up initially and can then be selected to 
apply to each job. 

Job Costing Features 

The major characteristics of Job Costing: 

• Time can be charged out and accounted for on an employee or resource basis for jobs 
taking place over a period of time. 

• Purchases can be made and applied directly to a job. 
• Work in progress may be a significant proportion of the businesses financial position at any 

time. The costs of this work can be included in financial reports covering the period they 
are incurred. 

• Different staff from different departments may be involved in a job and all costs can be 
collated. 

• Costs incurred on a job or the description of a job can be amended prior to job being 
finalised and invoiced. 

• Comprehensive reports can be created to monitor jobs in progress or analyse completed 
jobs. 

• Generation of necessary formal documentation such as invoices and quotes as well as user 
defined documents. 

• Serial numbers of stock items can be tracked from Purchasing through Work In Progress 
and onto Invoicing. 

General features of the Job Costing interface, common to other MYOB Exo Business modules: 

• Menu Designer 
• Contacts 
• Document Manager 
• Clarity reporting tools 
• Extra fields (on transaction lines also) 
• Custom Buttons 

Job Costing does not fully support the following advanced core MYOB Exo Business features: 

• Automatic processing  of build type BOMs during invoicing 
• One-off stock items 
• Batch numbers 
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The Job Costing workflow is represented by the following diagram: 

 

Job Costing Integration 

The Job Costing module integrates with Exo Business as follows: 

 

Note: As well as the integration illustrated here, it is also possible to post WIP to the 
General Ledger on a periodic basis (see page 127). 
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Setup Overview 

In order to accommodate the many different ways in which MYOB Exo Job Costing can be 
employed within service and project based businesses, it is necessary to have a comprehensive list 
of preference settings that define and modify the behaviour of Job Costing to suit these 
businesses. 

The process of setting up Job Costing, includes the following steps: 

• Detailing configuration changes to the MYOB Exo Business system (see page 3) to prepare 
for the use of Job Costing. 

• Installation and licensing (see page 6) of your Job Costing module 

• Providing an overview of the Job Costing structure (see page 10), including job status and 
related flags, job types and categories, and cost groups and cost types. 

• Setting up the Job Costing environment options (see page 29) before its initial use, 
including how to record standard (default) Job Costing information such as job types and 
categories to simplify the task of data entry. 

Note: A certified MYOB Exo Job Costing implementation partner normally performs the 
setup. This information is provided for completeness, and to help the advanced user s 
understanding of the Job Costing system. 

Setting up MYOB Exo Business for Job Costing 

The Job Costing module relies on some settings inside MYOB Exo Business for its initial installation 
and setup. Some changes to the Exo Business Configurator are therefore required before installing 
Job Costing. 

Set up Stock Integration 

MYOB recommends using the Periodic stock to GL method, rather than Perpetual stock, as this 
simplifies the system significantly. 

The General Ledger Integration option is set in the Business Essentials > General Ledger section 
of the Exo Business Configurator. An MYOB Exo Business partner should assist in this part of the 
configuration. 

Set up WIP Stock Location(s) 

One or more stock locations should be designated as Work In Progress locations. 

To set up a Work In Progress stock location: 

1. Open the Exo Business Configurator application (Exocfg.exe) and select the Admin tab. 
The Business Admin menu appears on the left hand side. 

2. Select Stock > Stock Locations from the Business Admin menu. The Stock Locations screen 
is displayed. 
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3. If no unused locations are available, click the New button to add a new location. The 
following warning message is displayed: 

 
4. Click Yes. A new location is added to the list. 

5. Select the unused location and double-click. The Details tab is displayed. 

 
6. Use the following table to complete the fields on the page. 

Field Description 

Location No The location number. Automatically assigned. 

Code The code related to this location, e.g. WIP . 

Name The name of the location, e.g. Work In Progress . 

Exclude from Free Stock Select if this location is not to be referenced when 
computing free stock. In this case of WIP this option 
should be enabled. 
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Exclude from Sales Select if this location is to be excluded from sales 
screens. Do not allow sales via Sales Orders or normal 
debtors invoicing from this location. This option should 
be disabled, so that Debtor invoicing is possible from 
Job Costing. 

Exclude from Valuation This setting allows stock valuation reports to be written 
to specifically exclude the WIP location. Normally this 
option is enabled for work in progress because its value 
should be taken from Job Costing itself, including the 
value of labour expended and unbilled subcontractors 
charges. 

Active Enable this option to ensure that the location is active; 
otherwise it will not appear in any drop down selection 
lists on transaction screens. 

Job Costing Work in 
Progress Location 

This option must be enabled, so that the location is 
designated as a WIP location. 

7. Click the Save button. The new WIP stock location will now be created and added to the 
location list. 

You now need to instruct Job Costing to use a WIP location. 

1. Still in the Exo Business Configurator application, select the Essential tab. The Business 
Essentials menu list appears on the left. 

2. Choose Exo Job Costing. 

 
3. Select a location for the WIP Stock location property. Only locations that have the Job 

Costing Work in Progress Location option enabled are available for selection. 
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Set up Work in Progress Control Accounts 

General Ledger accounts should be specified for the Work in Progress GL Control Accounts. 

To set up GL Control Accounts: 

1. Open the Exo Business Configurator application and select the Essential tab. 

2. Select GL Control Accounts from the Business Essentials menu. The GL Control Accounts 
screen is displayed. 

 
3. Go to the Custom tab and double-click on the Work in Progress Control Account. The 

General Ledger Account Search window is displayed. 

4. Select a GL account, then click Save & Close. 

5. Repeat steps 3 and 4 for the Work in Progress Stock Cost Variance Control Account. 

Installing/Upgrading Job Costing Overview 

This section explains how to install or upgrade the Job Costing module. If you need related 
information please contact your Exo Business partner. 

Note: Running Job Costing for the first time results in the creation of extra fields and tables 
within your Exo Business database. As with any upgrade ensure you have a good 
back-up of your database beforehand. 

Ensure Exo Business settings have been set up for use with Job Costing (see page 3). 

Note: Job Costing limits the users to 500 transactions in any demonstration system. 

Copy the Job Costing application (Jobcost.exe file) into the directory that contains your MYOB Exo 
Business application (Exonet.exe file).  

It is expected that all but the simplest Job Costing implementations will make extensive use of use 
Exo Business Clarity Reporting. Sample reports and business documents are provided, but may 
require customisation before they can be used. 

Ensure you have copied the minimum files required for Job Costing: 

• JobCost.exe 
• Clarity files 



MYOB Exo Business Job Costing 

7 

Installing Job Costing 

Run the MYOB Exo Job Costing application (Jobcost.exe) to launch the Job Costing application 
setup. The login screen appears: 

 
Log in as an Administrator, selecting the database currently used by Exo Business. Click OK. 

Job Costing displays a warning box asking you if you want to add this module to this database: 

 
Click Yes. An information box then appears asking you run the Exo Business Configurator 
(ExoCfg.exe) to initialise the database for Job Costing. 

 
Click OK. Job Costing will shut down, awaiting you to run ExoCfg.exe. 

Open the Exo Business Configurator application (Exocfg.exe). Login to the Configurator by typing 
the Administrator s user name and Password.  Select the same database chosen above (the 
database currently used by Exo Business). 
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Click OK. This brings up the Database Update screen: 

 
Ensure the Job Costing module is included in the selection as above. Click the Update button. As 
mentioned earlier, this results in the creation of extra fields and tables within your (selected) Exo 
Business database. The Report screen rolls through these changes.   
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The words Upgrade Completed  are displayed once the update is complete. Click the Close 
button. 
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Starting MYOB Exo Business Job Costing 

To open MYOB Exo Business Job Costing: 

1. Select MYOB Exo Job Costing from the MYOB Exo Business section of the Windows Start 
menu to launch the Job Costing application. The Exo Business login window is displayed: 

 
2. Enter logon details and click OK. The Job Costing main menu appears. 

Note: Once logged in, the Job Costing module may display a warning if you haven t 
previously set the WIP settings (see page 3). 

Job Costing Analysis 

Before installing Job Costing, thought should be put into the Job Costing Analysis Structure Chart. 
This will define how jobs will be structured for analysis. 

The highest natural grouping of transactions that exists is time and materials. Costs could logically 
be further broken down into direct purchases and stock. A key to the flexibility of the Job Costing 
lies in the appropriate use of Cost Types (see page 22) and Cost Groups (see page 20). 

Clues as to how your business might be broken down into Job Types (see page 14), Statuses (see 
page 15), Categories (see page 18), Cost Groups and Cost Types can be gleaned from the business 
forms that you use in the course of your businesses activity. These include Creditors Invoices that 
you receive, Debtors Invoices you produce, information written on time sheets and job cards, etc. 
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Analysis Available in MYOB Exo Job Costing 

The following diagram outlines the analysis available in Job Costing: 

 

Breaking Down Business Activities and Processes 

Use the following hints to help you analyse and breakdown the business activities and processes 
into MYOB Exo Job Costing terms. A large sheet of A3 Paper or a whiteboard, a photocopier and 
a number of sheets of A3 or A4 paper may be useful. 

Job Types and Job Categories 

Identify and write down at the top of the sheet the key departments or divisions within your 
company e.g. Servicing Division, Consulting division, Project management Division. These may be 
the Job Types (see page 14). 

Under each department heading, list any further divisions e.g. the servicing division may 
undertake warranty service work or time and materials service work. These may be the Job 
Categories (see page 18). 

Job Statuses and Job Flags 

Under each of the job categories write down every phase of work-flow that a job might go 
through from initial entry through to completion and archival. Organise these into a sequence if it 
isn t already. Consolidate these into a single shared list for all divisions. Carefully consider these 
and give each one a unique short-code letter, e.g. L = Lost Quote or S = To Schedule. These 
represent potential Job Statuses (see page 15). 

Collect examples of any relevant documentation associated with each of the above. Examples 
might include; Job Sheets, Quality Control Sheets, Invoices, Stock requirements sheets, Quotation 
forms and so on. 
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Duplicate the following on multiple sheets of paper and for each Job Status (stage in a job s life 
cycle), and identify key characteristics in terms of the following: 

SHORTCODE  _______   JOB STATUS NAME _____________ 

 
At this stage we wish to prevent entry of new transactions to 
this job. 

 At this stage we wish to prevent any changes to this job 

X At this stage the job is considered completed 

 
This stage the Job is considered archived and no longer 
current work. 

 At this stage we consider the Job to be ready for invoicing. 

X Jobs at this stage are considered active. 

X 
Jobs at this stage should not allow alterations to the quote or 
budget 

   
These will be useful when keying in the chosen job statuses (covered shortly). 

Next to each stage list any significant actions , tasks  or check-points  that you consider need to 
take place, e.g. Check Prices, Quality Check, Order Parts, Pick Parts, Invoice Now etc.  These are 
potential Job Flags (see page 27). 

Note: Too many job flags make the system cumbersome to operate and they soon fall into 
disuse. Ensure each flag will really be utilised - the fewer flags used the better. 

Job Resources 

Job Resources (see page 25) can encompass staff plus plant and equipment. Staff resources link to 
the staff table. When Job Costing is installed a resource is automatically generated for each 
existing staff member. Plant items may be manually added to the list by creating a resource that 
does not point at a staff member. 

Cost Types and Cost Groups 

The Cost Type (see page 22) is the lowest level of analysis and has the potential to connect directly 
to the General Ledger accounts and sub-codes that are set up in your chart of accounts. They can 
be grouped under Cost Groups (see page 20) (mainly for reporting and analysis purposes), 
although they need not necessarily be related in any way to Cost Groups. 

When performing the setup, it makes sense to set up Cost Groups first, as Cost Types can be 
linked to them in a hierarchy. Cost Groups (previously called Secondary Cost Centres in older 
versions of Exo Business) are much simpler in function and are really there for report grouping 
only. 

Existing Stock Product Group 1 or General Ledger revenue breakdown (accounts) might provide 
clues to appropriate transaction breakdown summary codes for Cost Groups. 

Existing Stock Product Group 2 or General Ledger revenue breakdown (Sub Accounts) might 
provide clues to appropriate transaction breakdown detailed codes for Cost Types. 
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Cost Types provide a method of defining different types of cost activities that occur during the 
normal process of business, in addition to reporting and analysis. Each Cost Type has several user 
settings associated with it. 

Much emphasis is placed on user defined shortcut keys. They allow rapid keyboard based 
transaction entry and avoidance of search screens once the shortcuts become familiar. 

Each Stock Item may also have its own default Cost Type and Cost Group.  These defaults are 
used unless overridden at time of entry. To do this you will need to select values in the Cost Group 
and Cost Type fields shown on the Extra fields tab of the Stock Item. 

Examples 

The following is an example of the resulting setup based on analysis of a typical Exo Business 
Partner s business involved in information technology consultancy and computer and network 
sales and services. 

JOB STATUS JOB TYPE JOB CATEGORY JOB FLAGS (USER) 

N NEW JOB 1 BENCH 1 NORMAL 1 BUILD 

P 
PRESALES 
TECHNICAL 2 BOOKED IN JOB 2 

C.O.B 
TOMORROW 2 BUILD COMPLETE 

Q QUOTE 3 DATABASE 3 
SERVICE 
AGREEMENT 3 FINANCE 

H SCHEDULED 4 HELP DESK 4 TODAY 5:00PM 4 FURTHER ACTION RQD 

O TO BE INVOICED 5 WEB DESIGN 5 
TOMORROW 
9:00AM 5 PASSED TO SALES 

B TO BE SCHEDULED 6 ONSITE 6 URGENT 6 PURCHASING 

U UNASSIGNED 7 OUTWORK 7 WITHIN 1 WEEK 7 RA 

W 
WORK IN 
PROGRESS 8 PHONE SUPPORT 8 WITHIN 24 HOURS 8 READY FOR DISPATCH 

T TEMPLATE 9 PRODUCT SUPPLY 9 WITHIN 36 HOURS 9 STAFF PURCHASE 

X CANCELLED 
1
0 PROJECT 

1
0 WITHIN 48 HOURS 

1
0 UNASSIGNED 

C COMPLETED 11 RECURRING JOB     11 WAITING ON AGENT 

I INVOICED 
1
2 REMOTE SUPPORT     

1
2 WAITING ON CLIENT 

L LOST QUOTE 
1
3 

SERVICE 
AGREEMENT     

1
3 

WAITING ON 
PAPERWORK 

    
1
4 SUBCONTRACTOR     

1
4 WAITING ON PARTS 

    
1
5 

TECHNICIANS 
HOURS         

    
1
6 UNASSIGNED         
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Below is another theoretical example from the construction industry: 

 

Setting Job Types 

A Job Type is the highest level of categorisation of a job. Jobs can be further broken down into 
Job Categories (see page 18), then Cost Groups (see page 20) (optional), then Cost Types (see 
page 22) (optional). 

For example, appropriate Job Types for Motorpartz might be Full Service, Tune, Tyres, Brakes and 
Customisation. 

To set up Job Types: 

1. Click Setup > Setup Job Types from the Job Costing menu. The Setup Job Types screen is 
displayed. 
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2. Click New. Type in the first required Job Type name. 

 

Field Description 

Job type no The system assigns a Job Type number on clicking save. 

Job type 
name 

A descriptive name for the job type. These could be taken from the 
Job Costing Analysis (see page 10). 

Gantt bar 
colour 

Select the colour to be used for jobs of this type on the Job Overview 
tab (see page 54). 

3. Click Save to save data or Cancel to lose all entries made. 

To add another Job Type, click New and repeat the process. 

Note: Job Types, Job Categories (see page 18), Cost Groups (see page 20) and Cost Types 
(see page 22) are given a key identity number by the system. This number cannot be 
directly controlled (except by using SQL directly and enabling IDENTITY_INSERT). As 
an alternative, create say ten in advance, manipulate the list into the order desired, 
and then delete any remainders. Do not delete items once there has been any 
likelihood that jobs have been created using these codes. 
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Setting Job Statuses 

A Job Status is used to indicate the status of a given job. Each one has a number of associated 
characteristics (flag settings) that dictate whether certain system-defined Job Flags (see page 27) 
are raised on changing to this status. Job Statuses are a vital part of the configuration of the Job 
Costing Module. 

For example, a job may be at the stage of Quote, New Job, Work In Progress, Finished or 
Cancelled. A job may in fact have two job statuses representing cancelled jobs; those which are a 
desirable job you cancelled as a result of losing a quote to a competitor (Lost Quote), and a similar 
cancelled status that represents when a quotation was withdrawn on the basis of the job being 
undesirable or not suitable work for your company. Both of these statuses would have the same 
characteristics of being non-active jobs, being considered Archived, and probably Locked. 
However it is possible to differentiate between these two cancelled statuses on analysis reports. A 
Job Status applies across all Job Types (see page 14). 

To set up Job Statuses: 

1. Select Setup > Setup Job Statuses from the Job Costing menu. The Setup Job Status 
screen is displayed. There may be a number of job statuses already created. Others can be 
added. 
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2. Click New. Type in the details of any further Job Statuses required. 

 

Field Description 

Job status key A meaningful one character unique short code to 
represent this Job Status. 

Job status name A suitable description of the job status, e.g. Work In 
Progress. 

Prevent new transactions System flag preventing entry of additional transactions 
to jobs of this status. 

Make job read only System flag to ensure that no part of the job can be 
edited while in this state. This includes the Status field 
itself. Only a user who has Job administrator rights can 
modify this job thereafter. By default all users have 
administrator rights. 

Jobs are complete System flag to mark jobs in this state as complete 

Jobs are archived System flag to identify that jobs in this state are 
considered archived and can be excluded from active 
lists of jobs. 

Jobs are ready to invoice System flag to identify jobs as ready to be invoiced. 
Invoice Clerks should look for these jobs. 
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Jobs are active 

  

System flag to include jobs in this state in any lists of 
active jobs. Default is Yes. 

Quotation is read only System flag used to lock the quote tab to prevent 
further changes while the job is in this status. Default is 
No. The quote tab will be locked unless logged in as a 
user with Job administrator rights. 

Workflow Constraints Apply When this flag is set the user may specify which 
statuses the job may move to. The status change can 
also be flagged to be tracked. 

Gantt bar colour Select the colour to be used for jobs of this status on 
the Job Overview tab (see page 54). 

3. When the Workflow Constraints Apply option is checked for a given status, you can click 

on the  icon to open a further screen to specify workflow status paths: 

 
4. Check the boxes in the Active column to specify which statuses you can move a job to 

from this status. If you want to record history of the status movement, then check the 
boxes in the Track Event column as well. 
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Setting Job Categories 

A Job Category is the second level of categorisation of a job, under the Job Type (see page 14). It 
can then be further broken down at line level into Cost Groups (see page 20) (optional), then Cost 
Types (see page 22) (optional). 

For example, appropriate Job Categories for the Motorpartz demo database, under a Job Type of 
Full Service , might be Oil Change , Fault Inspection , Replace Parts , and Miscellaneous . 

Another common use for Job Category might be to signify Urgent  and Non-urgent  jobs. 

To set up Job Categories: 

1. Select Setup > Setup Job Categories from the Job Costing menu. The job category search 
screen is displayed. 

 
2. Click New and type in the first required Job Category name. 
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Field Description 

Job category 
no 

The system assigns a Job Category number on clicking Save. 

Job category 
name 

A descriptive name for the Job Category. Descriptions could be 
taken from the Job Costing Analysis (see page 10). 

Short Code A short code to speed entry. Can be up to 3 characters. 

Gantt  bar 
colour 

Select the colour to be used for jobs in this category on the Job 
Overview tab (see page 54). 

3. Click Save to save data or Cancel to lose all entries made. 

To add another Job Category, click New and repeat this process. 

Setting Cost Groups 

A Cost Group is used to describe a group of activities that make up a Job Category (see page 18). 
Cost Group is an optional third level of categorisation of a job, under Job Type (see page 14) and 
Job Category. It can then be further broken down into Cost Types (see page 22) (optional). 

Cost Groups may be set up for some Job Categories but not others, as required. They may also be 
shared across different Job Categories. 

For example, appropriate Cost Groups for the Motorpartz demo database, under Job Type Full 
Service  and Job Category Replace Parts , may be Parts , Labour , Fitting Costs , 
Consumables , and Cleaning . 

To set up cost groups: 

1. Select Setup > Setup Cost Groups from the Job Costing menu. The Setup Cost Group 
search screen appears: 
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2. Click New. Enter the first of the required Cost Groups. 

 

Field Description 

Description A descriptive name for this Cost Group. Descriptions could be 
taken from the Job Costing Analysis (see page 10). 

Short code A short code to match the Cost Group description. This can be 
up to 3 characters long. 

Copy from quote to If information for this Cost Group needs to be copied from the 
quote to the Timesheet, Purchases or Costs tabs, select the 
required tab here. The information entered on the quote will 
not need to be re-entered in the selected tab but can be 
copied across. Leave as None  if this functionality is not 
required. 

The information in the selected tab can be changed after 
copying from the quote. 

Show on quote Allows specific Cost Groups to be displayed or not displayed on 
user defined forms (commonly the quote form). 

Consolidate Used with user-defined Clarity forms to present certain Cost 
Groups as consolidated into one total cost, e.g. Total Labour  
but parts detailed. Leave unselected if each group s costs are 
required to be shown separately, in detail. 

3. Click Save to save data or Cancel to lose all entries made. 

To add another Cost Group, click New and repeat the process. 
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Setting Cost Types 

A Cost Type is the (optional) lowest level of categorisation of a job. Cost Types are used to 
describe a product or activity, which can be added to other Cost Type products or activities, to 
make up a Cost Group (see page 20). A Cost Type activity or product can be made up of one or 
more items in the stock module. 

For example, appropriate Cost Types for the Motorpartz demo database, under the Cost Group 
Labour , may be Labour Standard , Labour 1.5 Time , and Labour Double Time . Appropriate 

Cost Types for Motorpartz under the Cost Group Cleaning  may be Tyre Cleaning , Engine 
Cleaning  and Interior Cleaning . 

To set up Cost Types: 

1. Select Setup > Setup Cost Types from the Job Costing menu. The Setup Cost Type screen 
is displayed. 
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2. Click New. Type in the first of the required Cost Types. 

 

Field Description 

Description A descriptive name for this Cost Type. Descriptions 
could be taken from the Job Costing Analysis (see page 
10). 

Short code A short code to match the Cost Type description. This 
can be up to 3 characters long. 

Copy from quote to If information for this Cost Type needs to be copied 
from the quote to the timesheet or costs tab, select the 
required tab here. Leave as None  if this functionality is 
not required. If selected, the information entered on the 
quote will not need to be re-entered in the chosen tab. 

The information in the selected tab can be changed 
after copying from the quote. 

Show on quote Select this option to display the Cost Type on the quote. 

Consolidate Select if all Cost Types are to be consolidated into one 
invoice line e.g. multiple entries of normal labour are 
totalled as one entry line. Leave unchecked if each 
type s costs are to be shown separately. 

Default markup (%) The percentage of the standard markup. Enter as a 
number e.g. 12.45 will be calculated as 12.45%. 
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Default overhead (%) The value of the standard overhead percentage. Enter 
this as a number e.g. 12.45 will be calculated as 12.45% 

GL code A General Ledger code for the Sales Account related to 
this item. 

Default purchases GL code A General ledger code for the Purchases Account 
related to this item. 

Default cost group The Cost Group this item belongs to. 

3. Click Save to save data or Cancel to lose all entries made. 

To add another Cost Type, click New and repeat this process. 

Cost Group and Cost Type Defaults 

Each Stock Item may also have its own default Cost Group (see page 20) and Cost Type (see page 
22). These defaults are used unless overridden at time of entry. Default settings may only be 
practical if stock items naturally fall into groups that reflect the way the jobs will be analysed. 

A common technique is to create shortcut codes using lookup only  stock items to allow single 
key entry of costs on the Cost tab. 

The default Cost Type and Group for a stock item is determined by the values in the Cost Group 
and Cost Type fields on the Stock Item > Extra Fields tab. 

COSTGROUP and COSTTYPE are added to the STOCK_ITEMS table automatically when Job 
Costing is installed, however by default they do not appear on the Stock Items screen. Add these 
fields as Extra Fields in Exo Business Configurator > System > Extra Fields. Set up the fields as 
follows: 

Field Value for Cost Groups Value for Cost Types 

Table name STOCK_ITEMS STOCK_ITEMS 

Field name COSTGROUP COSTTYPE 

Display name Cost Group Cost Type 

Dialog type Drop-Down Edit Drop-Down Edit 

Lookup table JOB_COSTGROUPS JOB_COSTTYPES 

Key field SEQNO SEQNO 

Display field COSTDESC COSTDESC 
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In Account > Stock Item select the item you wish to specify the cost group and cost type for and 
then navigate to the Extra Fields tab. Select the codes you require. 

 
If there are no values in these fields, then the user is expected to choose the Cost Type (and 
Group if required) on each line in Job Costing. 

Note: The Stock Items Details Screen can also be accessed from any Job Costing screen 
that has a stock code. Double-click on the stock item to access the Stock Items Details 
Screen. 

Setting Job Resources 

MYOB Exo Job Costing has a Job Resource table that is similar, but distinct from the Staff table. 
This provides the following benefits: 

• Allows the recording of time against non-staff resources such as plant and equipment, as 
well as employees. 

• Can help to keep staff cost rates private by using an anonymous stock code. 
• Gives the ability to default an activity stock code to each employee to speed up keying and 

help prevent mistakes. 
• Gives the ability to separate timesheet employees from the users of the Exo Business 

system, to ensure they are not unnecessarily shown in the login screens. 

Note: All existing employees are automatically added into the Resources table when Job 
Costing is installed. 
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To add and review Job Resources: 

1. Select Setup > Setup Job Resources from the Job Costing menu. The Setup Job Resources 
screen is displayed. 

 
2. To add a new resource, click New. Enter the required Resource Name, and other required 

information. 
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Field Description 

Staff If this resource is a staff member, select them from the drop-
down menu.  If it is a non-staff resource, leave this field blank. 

Note: If the resource is not associated with a staff member, Activities 
(see page 96) created for it will not appear on the Activity Search 
widget. It may be useful to set up a dummy staff account to 
associate non-staff Resources with. 

Name A descriptive name for this Resource. 

Short code A short code to match the name (initials) Resource description. 

Title Job title or use. 

Default Stock 
Code 

The default stock code associated with the resource. Used to save 
time keying timesheets. 

Active Select to mark the resource as active, to ensure it appears in Job 
Costing resource selection lists. 

Filter SQL to 
refine stock item 
search for times 

A partial SQL where  clause can be entered here to filter the 
stock search window. 

  

3. Click Save to save data, or Cancel to lose all entries made. 

To review an existing entry, double-click an entry to display the resource details. 

The cost and charge rate for that employee will be taken from the stock activity  code. 

Tips 

• Take some time to review the list and any staff members who are not involved in time-
sheeted work should be marked as inactive. Also take the opportunity to enter the initials 
into the Short code field as this will speed up entry. 

• Similarly, if the Labour  stock code being used is commonly the same one for a resource, 
enter this into the Default Stock Code edit box. The default stock code will be used only if 
the exact short code is typed into the timesheet. If searching for the resource, the stock 
code will need to be nominated manually. 

• To disguise the cost rate, make the stock code one that cannot be obviously related to the 
employee other than through the Job resource form. 

• If privacy is required, remove the option to set up Job Resources from all but the 
supervisor s menu once the rates have been set against each employee (resource). 
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Setting Job Flags 

There are a number of system-defined Job Flags that control the workflow and offer the 
opportunity to build in some customisable business logic constraints. 

 
There are also a number of user-definable job flags that can be manually set. Examples of these 
might be Awaiting parts  or Awaiting credit approval . These flags cannot be raised automatically 
by a change in job status like the systems flags. They can be very useful for reporting or 
controlling the flow of jobs around the business. All user flags are assumed to be False when the 
job is created, so the flag name should be phrased to reflect this, e.g. Quality Checked  is false 
until checked. Awaiting parts  is false until checked. The list of jobs that are Ready for installation  
might represent the installers  in-tray of work. The job Search is highly configurable and will 
remember the combination of flags and statuses picked as default search list. 

To set up Job Flags: 

1. Select Setup > Setup Job Flags Descriptions from the Job Costing Main Menu. The Setup 
Job Flags screen is displayed 

 
2. Double-click a Flag Code to edit the description. 

3. Click Save to update the description. 

Up to 15 flags are accommodated. Unlike Job Status (see page 15), multiple flags may be set on 
any particular job. 
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Setting Quote Terms 

To set the standard quote terms: 

1. Select Setup > Setup Quote Terms from the Job Costing menu. The Setup Quote Terms 
screen appears: 

 
2. Enter the standard set of terms and conditions of a quote. 

3. Click OK to save the information, or Cancel to lose the entry made. 

Job Costing Profile Settings 

Like most MYOB Exo Business products, the optional configuration settings in Job Costing are 
established by the use of profile settings, edited in the Exo Business Configurator application. 
There are three levels of settings: 

• Company profile settings (see page 30) - These are global to the database and control all 
users and computers. 

• User profile settings (see page 33) - These settings can vary according to the user logged 
on to Exo Business. 

• Computer profile settings (see page 37) - These settings can vary according to the 
computer that Exo Business is being run on. 

To configure profile settings, open the Exo Business Configurator application and select the 
Profiles tab. Select the Job Costing module filter to restrict the available settings to those that 
apply to the Job Costing module. 

Individual profile settings can be found by searching for keyword on their descriptions or by their 
internal name. In the profiles listed below the internal name is also shown for your convenience. 
To change the search field to operate on internal name use the combo to the left of the Find  
toolbar area. 

  



Setting Up 

30 

Viewing Profile Settings 

Setup > Setup General Info 

The General Settings window displays read-only information about the Job Costing system, 
allowing you to view the values specified by the Job Costing profile settings from within the Job 
Costing module. 

Open the General Settings window by selecting Setup General Info from the Setup menu of the 
main Job Costing window. 

Job Costing Company Profiles 

The following Company-level profile settings can be configured in the Exo Business Configurator 
for the Job Costing module. 

Allow editing of Locations of transaction lines 

Enable this setting to allow editing of Locations (From & To Loc) of each individual transaction line 
on a job in Job Costing. Note that the To Loc file is only editable if JOBMOVESTOCKONHAND & 
JOBMOVESTOCKONINVOICE profiles are not enabled. 

Allow invoicing of sub jobs from master jobs 

Enable this setting to allow invoicing of sub jobs from a master job, i.e. a single consolidated 
invoice is created for the master job and all of its sub jobs. 

Best pricing and discounting in Job Costing 

This option is enabled by default. Disable this option to disable discounting and best price 
checking in Job Costing. 

Caption for Our ref  

A caption for the Our ref field on the Details tab of the Job Details window (see page 38). It gives 
you another field of information you may wish to save. 

Cost field to use on Quote tab 

Select the Cost field to use on the Quote tab: Standard, Average or Latest. 

Cost method for Stock Items to use on Job Time and Cost tabs 
Cost method for Lookup Items to use on Job Time and Cost tabs 

Select the Cost methods for Stock items and Lookup items to use on the Timesheets and Costs 
tabs. (Job Quote entry has its own distinct and independent setting.) Available methods are 
Average, Last and Standard (static cost). 

Enable job code or reference number on sales order and debtor invoice entry screens 

Enable this option to record an optional job code or reference number on the Sales Order and 
Debtors Invoice entry screen. 

Enforce stock period locks in Job Costing 

When this option is enabled, any stock period controls that have been set up are enforced in Job 
Costing. A window appears when cancelling, writing off, moving or changing the quantity of a 
transaction line in a locked period, prompting the user to select a new date for the line. 

Get general ledger P/L revenue accounts from 

Select where the general ledger P/L revenue accounts are sourced from. Choose from: 

• Stock Item 
• Job Header 
• Cost Type 
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Integrate timesheets with PayrollEnterprise 

Enable this setting to activate integration with Exo Payroll (see page 71). This allows you to export 
timesheet data recorded against jobs to Exo Payroll. 

Job Cost Billing Mode 

Enter a list of billing modes to be available when entering new Jobs. 

The list may include: 

• C = Charge-up 
• P = Progress Invoice 
• A = Create Asset 
• Q = Ex-Quote 

The first in the list is the default billing mode. 

E.g. CP  would restrict the available modes to Charge-up or Progress Invoice modes, with Charge-
up being the default presented option if none are specifically selected. 

The default value is CPAQ. 

Job Cost Management Screen Auto Refresh Interval 

Job Cost Management Screen auto refresh interval in minutes. Default value = 0, i.e. no auto 
refresh. 

Job Overview Screen - Warning Threshold when Loading Jobs 

This value determines when to warn users if they are about to load too many records into the Job 
Overview screen (see page 54) (if the user attempts to load too many records, the system may 
appear to freeze). This value is the number of records that will be loaded before displaying a 
warning. The default value is 1,000; the optimal value will vary depending on the performance of 
your network and PCs. 

Job Purchase orders use Quote line Cost 

If this setting is enabled, Purchase Order lines generated from the Job Quote tab use the cost 
price as specified on the quote line. If the supplier uses foreign currency, the Quote line cost will 
be converted to the equivalent in that currency. If this setting is disabled, the cost price on the 
Purchase Order line will behave as though the Purchase Order was being generated normally, 
using normal supplier price logic, rather than from the quote line. 

Job Purchase orders use Quote line price 

If this setting is enabled, Purchase Order lines generated from the Job Quote tab use the selling 
price as specified on the quote line. 

Job Quote Labour Allowance calculation 

If this setting is enabled, the total quote line Labour allowance is to be considered a multiple of 
line unit labour allowance times the total quantity on that line. 

If the setting is not enabled, it is considered to be an absolute value per line. This affects the Total 
labour allowance displayed at the bottom of the quote screen. 

Tip: You can predefine a labour allowance for all Stock codes by adding an extra field 
X_LABOUR_ALLOWANCE of Type DOUBLE with a default value of 0 to the 
STOCK_ITEMS Table. This value will be passed to the quote whenever you insert a 
new line. 
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Link Our ref  to sales order number lookup 

If this setting is enabled, you can enter the number of the Sales Order associated with a job into 
the Our ref field on the Details tab of the Job Details window (see page 38). The Sales Order can 
then be viewed by selecting View Sales Order from the Utilities menu. 

Resources - Check for Resource Over-Allocations 

If this setting is enabled, the system checks for overlaps and over-allocations when allocating 
resources or altering resource allocation. This includes cases where a resource allocation overlaps 
another allocation of the same resource, and when the resource is allocated for more than the 
target hours per day. If any resources are over-allocated, you are presented with a warning 
message, and given the option to view and correct the over-allocations. 

Resources - Synchronise Job and Resource Dates 

If this setting is enabled, the system checks that start and end dates/times for resource allocations 
are within the Start Date - Due Date range. If allocations fall outside this range, you are presented 
with a warning message, and given the option to view and correct the allocation dates. 

PayrollEnterprise export location 

This setting must be configured when integrating with Exo Payroll (see page 71). Specify the root 
directory of the Exo Payroll installation, e.g. C:\Payrollv. 

PayrollEnterprise Database Location 

This setting must be configured when integrating with Exo Payroll (see page 71). Specify the 
database directory of the Exo Payroll installation, e.g. C:\Payrollv\DATABASE. 

SQL statement to refine stock item search for costs 

An SQL statement to refine search criteria for stock on the Cost Tab of the Job Management 
Form. e.g. AND STOCKGROUP <>4  (if Labour is stock group 4 it will not be included in the results 
of the search).For further assistance contact your Exo Business trained professional. 

SQL statement to refine stock item search for times 

An SQL statement to refine the search criteria for stock on the Timesheet Tab of the Job 
Management Form e.g. AND STOCKCODE = 4 (if the stockcode for labour is 4, labour will be 
included in the search result). For further assistance contact your Exo Business trained professional. 

SQL statement to select cost of sales GL accounts 

Search criteria, e.g. WHERE ACCNO<200.  This example applies if cost of sales GL accounts is 
numbered less than 200. For further assistance, contact your Exo Business trained professional. 

SQL statement to select sales GL accounts 

Search criteria, e.g. ACCNO>1000.  This example applies if Sales GL accounts are numbered 
greater than 1000. If Sub-Accounts are enabled, aliases must be used for ambiguous field names. 
Aliases are A=GLACCS and S=GLSUBACCS, e.g. A.ACCNO>2000 AND S.SUBACCNO<3. 

For further assistance contact your Exo Business trained professional. 

Sub job transactions add to master job totals 

Select this option to automatically add Sub-job invoice totals to the Master Job. 

Time sheet default end date 

Select the default end date for new timesheets. Choose from the Due date, the Start date or 
today s date. 
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Use current date on Time sheets entry 

If this setting is enabled, the start dates on Time Sheets entry will be the current date; otherwise, 
the Job Start date will be used, but only if it is defined. If no Job Start date is set, Time Sheet start 
date will use the current date instead. 

Job Costing User Profiles 

The following User-level profile settings can be configured in the Exo Business Configurator for 
the Job Costing module. 

Allow creation of new Make, Model and Class 

If this setting is enabled,  Makes, Models and Classes can be created from the Serviceable Units 
window (see page 105). 

Allow editing of job cost invoicing 

Allows immediate editing of Invoices as they are generated from Jobs. Changes made will not 
adjust the values of the cost lines that were used to create the Invoice (this must be done on the 
Invoice tab of the Job), but the value of the invoice will show on the Job Analysis tab. By enabling 
this option, you are also be able to generate Invoices on a job that has no currently invoice-able 
lines in the Ready to Invoice  state, e.g. Initial non-refundable down payment or progress based 
Invoice. 

Calculate Hours  from Start  and End  times in timesheet entry 

Enable this option if you do not require the user to enter Total Time . If you select this option, 
Total time  will be automatically calculated from the start dates and start times entered. Many 
users find that entering times and dates is inefficient and prefer to enter total hours. 

Default Category 

Default Category (see page 18) when entering a new Job in Job Costing. 

Default Job Status 

Default Job Status (see page 15) when entering a new Job in Job Costing. 

Default Job Type 

Default Job Type (see page 14) when entering a new Job in Job Costing. 

Default Status of Job Transactions on Entry 

Select the default status of new job transactions. Choose from: 

• C - Committed 
• W - Write-off 
• R - Ready to Invoice 

You might set this value to R  if the transactions you are entering do not usually require any 
further checking after initial entry and you therefore want all transactions entered onto a job to be 
automatically ready to appear on the next Job Invoice. 

Default the Job Manager as Sales person on invoices from Job Costing 

Enable this option to set the default Sales Person on invoices from Job Costing to the Job 
Manager. If the option is disabled, the default Sales Person is set to the currently logged in user. 

Default the Job Manager from Debtor Account Staff 

Enable this option to obtain the default Job Manager from the Debtor Account staff. If the option 
is disabled, the default Job Manager is set to the currently logged in user. 
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Display internal job number after saving 

Enable this option to display the job number every time a job is saved. 

Extra Job Costing Search Fields 

The format to extend Extra Search Fields is: 

• ADatabaseFieldName=FriendlyCaption=SearchBehaviour 
• Multiple fields are separated by commas 
• The =FriendlyCaption=SearchBehaviour is optional 

For Example: X_AFIELD=A Caption,X_ANOTHERFIELD=Another Caption,X_THIRDFIELD 

Additional control over the extra search field behaviour is set as follows: 

If no behaviour parameters are passed in, it assumes a default search behaviour of GSWU where: 

• =G - show this field as an optional visible column in the search grid. 
• =S - add this field as part of the select statement. 
• =W - make this field value a condition in the WHERE clause. 
• =U - force a character to uppercase for comparison. (String Fields) 
• =E - use Exact match (=) in the where clause rather than LIKE. (String Fields) 

For Example: X_MyField1=Mycaption=GSWUE,X_Myfield2=MyField2=E 

Ambiguous field names (field names that exist in both tables) should be prefixed by a table alias. 

For Example Alias.FieldName,Alias2.FieldName 

The list of aliases is: 

• J=JOBCOST_HDR 
• A=DR_ACCS 
• S=JOB_STATUS 
• C=JOB_CATEGORIES 
• R=JOB_RESOURCE_ALLOCATION 
• F=JOBCOST_FLAGS 
• G=JOB_TYPES 
• H=STAFF 

Go direct to job management screen on startup 

Enable this option to display the Job Management screen on startup. 

Hide tabs in Job management screen 

Allows you to hide Tabs on the Job Management Screen. Enter the codes for all tabs you want to 
hide, separated by commas. Available codes are: 

• Q = hide the Quote/Budget tab 
• T = hide the Timeshets tab 
• C = hide the Costs tab 
• A = hide the Analysis tab 
• P = hide the Purchases tab 
• I = hide the Invoice tab 
• D = hide the Documents tab 
• E = hide the Extra Fields  tab 
• H = hide the History Notes  tab 
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• S = hide the Sub-jobs  tab 
• X = hide the Dashboard tab 
• B = hide the Billing Schedule tab 

For example, enter Q,T,I  to hide the Quote, Time and Invoice tabs. 

Hide Quote Margin 

Enable this option to hide the Margin field displayed at the bottom of the Quote/Budget tab (see 
page 57). 

Hide Quote Markup 

Enable this option to hide the Markup field displayed at the bottom of the Quote/Budget tab (see 
page 57). 

Hide Quote Total Cost 

Enable this option to hide the Total Cost field displayed at the bottom of the Quote/Budget tab 
(see page 57). 

Hide Resource Planning Gantt Form 

When this setting is enabled, the Resource Planning tabs on the Job Management window (see 
page 102) and the Setup Job Resource Allocation window (see page 101) are hidden. 

Job costing custom button X caption 

Custom button (see page 126) caption settings are available for each of the nine custom buttons. 
Enter a caption for the appropriate button. 

Job costing custom button X command line 

Up to nine custom buttons (see page 126) are provided for you to add your own shortcuts to many 
of the main screens. 

For the desired button, specify the details of the sub-program to be run whenever you press that 
button. 

• To run an external program, enter: 

MyProg.EXE <LOGIN> <CURRENT>  

Where <LOGIN> passes the database connection details and <CURRENT> passes out the 
key field identifier (most commonly the SEQNO) of the current record that you have loaded 
on the screen at the time that you press the button. 

• Any parameter entered with the extension MYREPORT.CLR will assume that you wish to 
run a clarity report and will call Clarity directly. It is not necessary that Clarity.EXE exist to do 
this. 

• Any parameter entered with an extension of MYREPORT.RPT will assume that 
CRYSTAL.EXE should be run first. 

Job Costing Read-Only Access 

Enable this profile to restrict users to read-only access in the Job Costing module. 

Job Default due days 

Default number of days after Job start date. 

Job Default end time 

Default number of hours after Job start time. 
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Job Default follow-up days 

Default number of days for follow-up after Job completion. 

Job default quote expire days 

Default number of days for job quotes to expire. The defaults is 14 calendar days. 

Override Job Codes 

Enabling this option allows the user to override the system-assigned Job Code any time. 

Prompt if different delivery address on Job 

Enable this profile to be prompted whenever a debtor s current delivery address is not the same 
as the delivery address in a job. Probable use would be where a job is being rejuvenated or 
repeated after a long period of time, and the debtor has moved premises. 

Prompt if Job Code is blank 

If this option is enabled, the user is prompted if the Job Code on a transaction line is blank in 
Purchase Orders and Creditor s Invoices. You might disable this if only a proportion of purchases 
relate to jobs. 

Remember Stock Search Form size 

Enable this option to remember the size of Stock Search Form between sessions. 

Restrict access to jobs on default branch only 

Enable this profile to restrict access and creating of new jobs to the default branch only. 

Restrict Timesheet entry to Resource associated to logged-in Staff 

Enabling this option restricts the Resource to the Resources associated with the currently logged-
in Staff member. 

Serviceable Unit Custom Button1 Caption 

The Serviceable Units window contains single a custom button (see page 126). Enter a caption for 
the button. 

Serviceable Unit Custom Button1 EXE 

A single custom button is provided on the Job Costing window for you to add your own shortcuts 
to many of the main screens. 

Specify the details of the sub-program to be run whenever you press that button (see the 
information on the Job Costing custom buttons above for details). 

Show Job Overview screen needs refresh warning 

The Job Overview tab (see page 54) does not refresh automatically as job details are changed. If 
this setting is enabled, a warning appears on the Job Overview whenever job details change, 
informing the user that they need to refresh the display. 

Show Resource Overview screen needs refresh warning 

The Resource Overview tab (see page 102) does not refresh automatically as job details are 
changed. If this setting is enabled, a warning appears on the Resource Overview whenever job 
details change, informing the user that they need to refresh the display. 

Show the Resource Allocations moved with Job  warning 

If this setting is enabled, a warning appears on the Job Overview tab whenever a job with 
resources attached to it is moved, informing the user that the associated resource allocations have 
changed. 
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User can modify visible columns in grids 

If this option is enabled, the Select visible columns option is available in the right-click menu for all 
ExoGrids in the Job Details window. 

User has Job Administrator Rights 

Enabling this option means that the user can edit the status of jobs that contain the characteristic 
of Job Read Only . 

Warn if cash sales account is used on jobs 

Enable this option to alert the user if they are about to create a job to a cash sale, or if they do not 
choose the account. It is advisable to do this, as it will prevent invoices inadvertently being created 
as a cash sales. 

Weekly timesheet resource auto defaults from staff login 

If there is a matching resource for the staff login, then the weekly timesheet opens with that 
resource. 

Write of job lines when generating a credit note 

When a credit note is generated from a job, the credited lines can be written off automatically if 
this setting is set to Prompt . If it is set to Never , lines will have to be written off manually. 

Job Costing Computer Profiles 

The following Computer-level profile settings can be configured in the Exo Business Configurator 
for the Job Costing module. 

Asset default location 

The default output location when creating an asset in Job Costing. 

Job work in progress stock location 

The Work in Progress stock location for Job Costing. Only locations that have their Job Costing 
Work in Progress Location flag ticked are available for selection. 
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Creating Jobs 

New jobs are created from the Job Management screen. From here new jobs, sub jobs and 
duplicate jobs may be created. 

To create a new job: 

1. Select Account > Job Management Screen from the main Job Costing menu. The following 
window appears. 

 
2. Select New to begin a new job. A new window may appear with a warning as follows: 

 
This warning is an alert that unless a customer account is chosen the job will be saved as 
CASH ONLY. Click OK. This will allow entry of details into the new Job Screen. 

Note: Whether or not this warning appears is controlled by the Warn if cash sales account is 
used on jobs User-level profile setting (see page 33). 
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3. The main job entry window is displayed: 

 

Field Description 

Job details   

Code A unique code for the job. It may be up to 15 alphanumeric 
characters. If a code is not entered, it will default to the system-
assigned job number. 

Allow Invoice via 
Master Job 

This option appears if the job is a sub job. If it is ticked, the job 
can be invoiced from its master job. 

Title The title of the job. This should be a short recognisable job 
description. 

Status A Job Status (see page 15) to identify the current stage of the 
job. Select the appropriate status from the drop down list. 

If the status is unable to be changed, then the current status of 
the job may dictate that the job is entirely read-only and only an 
administrator can alter it. This is controlled by the Make job read 
only option when setting Job Statuses (see page 15). 

Type A Job Type (see page 14) selected from the drop down box. The 
default is set by a user-level profile setting (see page 33). 

Category A Job Category (see page 18) selected from the drop down box. 
The default is set by a user-level profile setting (see page 33). 
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Account Accept the default Cash Sale account or enter a customer code. 
If the code is unknown, enter ? and press TAB, select from 
displayed list. To drill to the account details, double-click on this 
field after an account has been selected. 

Campaign Wave 

  

This field is available if the Exo Business CRM module is installed. 
A job can be associated with a campaign wave, for example, to 
capture the fact that the job was created as a result of a 
campaign. This allows you to report on the effectiveness of the 
campaign. 

Note: Job Costing can also be used to provide advanced 
costing for a campaign. This is done by opening the 
campaign in Exo Business CRM and selecting the job to 
use for costing the campaign in the Campaign Costs 
field. 

Opportunity This field is available if the Exo Business CRM module is installed. 
If the job was generated from an Opportunity, the Opportunity 
will be entered here automatically; otherwise, one can be 
manually entered (enter ? and press TAB to search for an 
Opportunity). 

Customer   

Job Mgr Select a staff member from the drop down box. The default staff 
member is either the staff member associated with the Debtor 
account, or the currently logged in user, depending on the 
Default the Job Manager from Debtor Account Staff User-level 
profile setting (see page 33). 

Cust order no A customer order number, if required. 

Contact The name of the contact person. This field may be left blank. 
Contacts will allow job/debtor-related subcontractors and site-
related information such as job Site address and Site foreman to 
be stored. 

Clicking the edit button will display a list of known contacts 
associated with the account. Double click to select or click New 
to add a new contact to the account. 

See the MYOB Exo Business online Help for instructions on 
adding a Contact. 

Site address The address(es) of the job site. Manually enter an address, or use 
the Additional Addresses (see page 43) button. 

Dates   

Create Date Date and time that the job was created. Cannot be edited. 

Quoted date Record a date and time when the quote was created. 
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Start date Record the start date/time of the job. Either in advance or when 
the job actually starts. 

Due date Date and time that the job is expected to be completed. Defaults 
to Start time + the value of the Job Default due days user-level 
profile setting (see page 33). 

Completed date Date and time of actual completion. 

Follow-up date Defaults to the Job Default follow-up days user-level profile 
setting (see page 33). Designed to provide a way to report on 
jobs that are due for service, or customer satisfaction survey at 
an appropriate time after an installation. 

    

Branch Enter the Branch code for this job. Defaults to the user s branch 
profile setting. 

WIP Loc The Work in Progress stock location. Defaults to the Job work in 
progress stock location computer profile setting (see page 37). 
Once lines have been entered for the job, this field becomes 
read-only. 

Entered by Select an active staff member from the drop-down 
menu. Defaults to the currently logged-in user. 

Our Ref A reference that can be searched on the main job search screen. 

If a Sales Order has been created for the job, enter the Sales 
Order number here. You can view the Sales Order by selecting 
View Sales Order from the Utilities menu, provided the Link Our 
ref  to sales order number lookup profile setting has been 
enabled. 

    

Billing Mode The billing mode determines how the Job will be charged. 
Choose from: 

• Charge-up - charge items added to the job 

• Invoice Ex-Quote - the quoted value will be charged. 

• Manufacture - output items - the job will create stock 
assets (items) for on-sale. 

• Progress Invoices - the job will use progress billing (see 
page 120). 

  



Creating and Searching for Jobs 

42 

    

Extra fields The Extra Fields section displays optional addition fields that can 
be used to record business specific information, which are set up 
by an MYOB Exo Business partner. The first five Extra Fields are 
displayed here, while any additional fields are displayed on a 
separate Extra Fields tab. 

Note: The Extra Fields tab is only available if Extra Fields have been 
defined for position 6 or later. 

Sub-tabs   

Description Enter any extra explanatory details relating to the job, which can 
be included on the invoice. 

The content of this field is scanned when you select the Extensive 
job search option. If there is a value in this field then the tab will 
appear highlighted. 

Notes Enter general narration Notes about the job. This field is usually 
used for private notes, and is not included in the customer 
invoice. The content of this field is scanned when you select the 
Extensive job search option. If there is a value in this field then the 
tab will appear highlighted. 

Serviceable Units This tab only appears if the Serviceable Units (see page 104) 
module is installed. It allows a list of serviceable units to be 
assigned or created for the job. At line level the particular 
serviceable unit can be selected from this list. 

Output Item Allows pre-loading the output item (asset stock codes) that will be 
produced from this job. 

Job Flags These are flags (see page 27) that can be set against the job. 
Multiple flags can be checked. There are two groups of flags: 
System Flags are predefined, while Custom Flags are created by 
the implementer. 

Timestamps 

Key fields such as the Description and Notes support the ability to quickly stamp  the field with 
the current logged in user name, and the system time and date. 

To create a time stamp, press CTRL+T in a supported field. A time stamp like the following is 
inserted at the current cursor point: 
 

 << FRED  Tuesday, April 1, 2016 at 09:16 >> 
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Common Phrases 

A library of common phrases can be built to save typing and assist with retaining a generic format 
to notes. 

To select or create a common phrase press CTRL+  (single quote), or CTRL+  (double quote) in a 
supported field. The Common Phrases window appears: 

 
To add a phrase, type the phrase and click the Add Phrase button. 

To select a common phrase to the text box, begin typing the phrase and the cursor will focus on 
the nearest match in the search grid. Either click OK to select the highlighted phrase, or double-
click the phrase required. 

To delete a phrase from the list, highlight the phrase to be deleted and click the Del. Phrase 
button. 

Selecting Site Addresses 

To assist in site address entry, an additional Select Address button is available on the toolbar. 

Click this button, and a prompt will appear to give the option to choose from all stored delivery 
addresses, ignoring the specified account (Yes), or restrict addresses to the account specified (No). 

A list of addresses to select from is displayed: 

 
Additional addresses may be added by clicking the New button, or the desired address added to 
the job by selecting the appropriate address and clicking the Select & Close button. 
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Serviceable Units 

Serviceable Units (see page 104) functionality is an optional module which is not installed by 
default. This tab may therefore be absent from your screen. Serviceable units refer to items on 
which work may be required. These could be assets of the company running the Job Costing 
module or assets owned by their customers (perhaps previously sold to the customer). 

Output Items 

Jobs may create products of value that are not invoiced directly to the customer, but instead 
create stock of value that can be sold via Debtors Invoicing or Sales Order entry (manufacturing). 
This is referred to as creating an asset. The output items are created as part of the invoicing phase 
of the job (see page 81) and may be specified at that time but may also be pre-loaded here and 
later referenced in the Create Asset > Create Asset from Output Items routine (see page 86) on 
the Invoice tab. 

Saving the Job 

Once the header information for the job has been entered, three options for saving are available: 

• Save & Exit - saves the details and returns to the main search menu, ready to create the 
next job. 

• Cancel - abandons all entries made. 
• Save - saves data and continues with entering data on this job. 

Once the job header has been saved, a series of tabs become available next to the Details tab. 
These are used to change from one type of entry to another associated with the same job: 

• Quote/Budget (see page 57) 
• Timesheets (see page 65) 
• Costs (see page 73) 
• Purchases (see page 79) 
• Invoice (see page 81) 
• Analysis (see page 92) 
• Documents (see page 92) 
• History Notes (see page 94) 
• Sub Jobs (see page 46) 
• Activities (see page 96) 

A Dashboard tab is also available. This tab contains a blank Dashboard interface, which can be 
customised with whatever widgets you require. 

The tabs may be reordered to a different sequence by dragging them to a new position. They 
may then be locked into this position via the menu by selecting Utilities > Lock Tabs. Most tabs 
contain a grid with resizable columns. By selecting Utilities > Lock Column Widths you can prevent 
accidental resizing. Both of these settings are toggles. Clicking them a second time unlocks the 
setting. 

Tabs can be hidden by editing the Hide tabs in Job management screen User-level profile setting 
in Exo Business Config. 



MYOB Exo Business Job Costing 

45 

Creating Projects 

Jobs can be organised under projects for display on the Job Overview tab (see page 54) of the 
Job Management Screen. Projects act as containers for related jobs, and hold no job-related 
information themselves. 

 
Projects can contain a hierarchy of master jobs with sub jobs, although projects themselves cannot 
be nested, i.e. one project cannot contain another. 

Note: A sub job cannot be assigned directly to a project; sub jobs are assigned to a project 
when their master job is assigned to the project. 

To create a new project: 

1. On the Job Overview tab, right-click on the first job that you want to add to the project 
and select Add to Project. The Choose a Project window appears: 
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2. Click New to add a new project. The Project Details window appears: 

 
3. Enter a name, code and description for the project, then click Save & Exit. 

Note: The Status property displays Active  if the project has and jobs assigned to it and 
Inactive  if it currently has none. 

4. The new project now appears on the Choose a Project window. Select it and click Select 
and Close. 

The new project is created and the selected job is assigned to it. More jobs can be assigned to the 
project by selecting Add to Project from the right-click menu, then choosing the project from the 
Choose a Project window. 

Tip: Jobs can be automatically assigned to projects when they are created. Select a project 
on the Job Overview tab, then click the New toolbar button or select New from the 
File menu. When the new job is saved it will be automatically assigned to the selected 
project. 

To remove a job from a project, right-click on the job and select Remove from Project. 

To edit a project s name, code and/or description, right-click on it and select Edit Project. 
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Creating Sub Jobs 

Sub Jobs are jobs that are linked to a master job. They usually represent distinct parts of the job 
for the purpose of simplifying overall reporting. In every other way sub jobs are normal jobs. 

Note: A master job must be created before a sub job can be entered. 

To create a new sub job: 

1. Choose File > New Sub Job from the Job Management window. 

2. Select the master job that the new sub job is to be associated with from the Search 
window that appears. 

3. Fill in all details in the same way as when creating a new Job (see page 38). 

The created sub job is numbered and is shown as a sub job on the Sub Jobs tab of the selected 
master job. 

Tip: The job code for the sub job could include part of the master job number or code, for 
easy cross-referencing. 

Working with Sub Jobs 

A sub job can be identified by looking at the status bar at the top of the job. 

 

To go to the master job from a sub job, click the View Master Job button (  ) on the toolbar of 
the sub-job. 

The master job contains an extra Sub Jobs tab that contains a list of sub jobs attached to that 
master job. 

An Include Sub Job Lines option is available on the Quote/Budget, Timesheets, Costs and Invoices 
tabs - enabling this option shows lines for all sub jobs in the main grid. The Job Code column on 
these tabs contains a dropdown that lets you select a specific sub job to show on the grid. 

The Analysis tab of a master job (see page 92) displays totals for all related sub-jobs: 

 
A job cannot be connected to, or disconnected from a master once the job has been created. 

If the Allow invoicing of sub jobs from master jobs Company-level profile setting (see page 30) is 
enabled, sub jobs are invoiced from their master jobs - a single invoice is created (see page 84) for 
the master job and all of its sub jobs. 
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Creating a New Duplicate Job 

A duplicate job can be easily created using an existing job as a starting point. If there are sub-jobs 
attached to the job being duplicated a prompt will appear to confirm whether the sub-job(s) are to 
be included. It is not necessary to duplicate all sub-jobs  select the sub jobs required to be 
duplicated. 

To create a duplicate job: 

1. Select File > New Duplicate Job from the Job Management menu. The following window 
appears: 

 
2. Double click the job to be copied. The following window appears to confirm to what extent 

the jobs details are to be duplicated: 

 
3. Select the features of the job that are to be duplicated and click OK. 

The newly created job is given the next appropriate number. 
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If the Duplicate any sub-jobs option was selected, the following window will appear after the 
copy of the master job is saved: 

 
1. Select a sub job to be added to the new job. 

2. Click Add or double-click the job to be added. 

3. Save the newly created sub job after making necessary alterations. 

4. Continue adding until all required sub jobs are added. 

5. Close the window. 

Note: Subs jobs are not displayed on the master job screen until the master job is saved. 

Direct New Job Entry 

The Direct New Job Entry window is a fast entry window that allows you to create new jobs 
quickly. Once created, new jobs can be edited as normal on the Job Details window (see page 38). 

Open the Direct New Job Entry window by selecting the Direct New Job Entry menu option. 

 



Creating and Searching for Jobs 

50 

Note: If the Direct New Job Entry menu option is not available, you will need to add it 
using the Menu Designer. 

To create a new job using the Direct New Job Entry window, enter the details below and click 
Save. 

After one job has been entered and saved using the Direct New Job Entry window, you can click 
New to enter a new job. The details of the saved job remain on the window (with the exception of 
the Code, Title, Account and Cust order no.) - this allows you to quickly enter multiple jobs with 
similar details. 

Field Description 

Job details   

Code A unique code for the job. It may be up to 15 alphanumeric characters. If a 
code is not entered, it will default to the system-assigned job number. 

Title The title of the job. This should be a short recognisable job description. 

Status A Job Status (see page 15) to identify the current stage of the job. Select the 
appropriate status from the drop down list. 

If the status is unable to be changed, then the current status of the job may 
dictate that the job is entirely read-only and only an administrator can alter it. 
This is controlled by the Make job read only option when setting Job 
Statuses (see page 15). 

Type A Job Type (see page 14) selected from the drop down box. The default is 
set by a user-level profile setting (see page 33). 

Category A Job Category (see page 18) selected from the drop down box. The default 
is set by a user-level profile setting (see page 33). 

Job Mgr Select a staff name from the drop down box. This staff member can override 
the salesperson on all invoices created from a job, (subject to a user profile 
setting). 

Dates   

Quoted Record a date and time when the quote was created. 

Start Record the start date/time of the job. Either in advance or when the job 
actually starts. 

Due Date and time that the job is expected to be completed. Defaults to Start 
time + the value of the Job Default due days user-level profile setting (see 
page 33). 

Completed Date and time of actual completion. 

Customer   

Account Enter a customer code. If the code is unknown, enter ? and press TAB, select 
from displayed list. 
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Cust order no A customer order number, if required. 

Contact The name of the contact person. This field may be left blank. Contacts allow 
job/debtor-related subcontractors and site-related information such as job 
site address and site foreman to be stored. 

Clicking the edit button displays a list of known contacts associated with the 
account. Double-click to select or click New to add a new contact to the 
account. 

See the MYOB Exo Business online Help for instructions on adding a 
Contact. 

Other   

Entered Select an active staff member from the drop-down menu. Defaults to the 
currently logged-in user. 

Our Ref A reference that can be searched on the main job search screen. 

If a Sales Order has been created for the job, enter the Sales Order number 
here. You can view the Sales Order by selecting View Sales Order from the 
Utilities menu, provided the Link Our ref  to sales order number lookup 
profile setting has been enabled. 

Description Enter any extra explanatory details relating to the job, which can be included 
on the invoice. 

The content of this field is scanned when you select the Extensive job search 
option. If there is a value in this field then the tab will appear highlighted. 
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Searching for an Existing Job 

To search for an existing job, select Account > Job Management Screen, from the Job Costing 
main menu. The following screen appears: 

 
The Search tab is displayed by default. The following tabs are also available: 

• Job Overview (see page 54) 
• Resource Overview (see page 102) 

Applying Job Filters 

The job filters at the top of the Search tab allow the search results to be filtered  to facilitate 
processing of jobs within certain ranges . 

By default all of the filter options are displayed, but if your implementation does not employ all of 
the categorisations of jobs you can hide selected options using the toolbar View settings. 

 
Tip: The thin line between the filters and the search key can be dragged to use more or 

less screen space for the filter options. 
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Select the check box next to the filter title to enable that filter. This check box allows an entire filter 
to be enabled or disabled, without altering the individual settings of the filter items, e.g. in the 
example above, filtering by Job flags and Job statuses is enabled, but Job types do not form part 
of the filter. 

Once a specific filter has been enabled, individual filter settings can be selected. 

Filter Description 

Job Flags Tick these boxes to show jobs that have the selected job flags (see page 27) 
associated with them. Flags are updated whenever the job is saved. Their 
settings are based on the characteristics of the current job status. 

Job Statuses 
Job Types 
Job Categories 

Tick these boxes to show jobs that have the selected job statuses (see page 
15), types (see page 14) and/or categories (see page 18). 

Resources Shows jobs that involve any of the resources (see page 101) selected. 

Entered by 
Serviced by 

Select from a list of active staff members to show jobs that have been 
entered/serviced by them. 

Tip: Right-clicking in an activated flag set provides the option to tick or un-tick all options in 
one step 

The computer remembers the combination of selected filter options. This allows the search screen 
to be set up for specific workflow purposes at specific workstations, or enables the options to be 
remembered if the user works in a consistent way. 

Performing the Search 

Once the optional filter options have been selected, enter text into the Search key field that will 
sufficiently narrow down the list of jobs returned in a search. This would part of the job code, 
customer name, job title, or our ref  reference field. 

If the Extensive search option is selected, the Search key will also be checked against the contents 
of the description and notes fields. While more comprehensive, it will cause the search to take 
longer to list the results. 

Clicking Search will list all jobs matching the statuses ticked in the box at top of the screen and the 
criteria entered into the Search key field. 

Some job lines are colour-coded to indicate their status or job flags: 

• GREEN = Invoice Ready 
• RED = Completed 
• OLIVE = Archived 
• PURPLE = Overdue 

From the list that appears, select the required job. The screen that is displayed shows the job 
details, as entered when the job was created. Changes can then be made to the job. 

Note: The search result grid is an ExoGrid and can therefore be used to sort, shuffle or only 
display selected columns. Any extra fields that are added to the job header will 
become available as extra columns of the job list, although these columns are not 
matched against the search key. 
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Applying Custom Filters 

An additional customisable filtering mechanism can be used to filter the records displayed in the 
grid. This custom filter is accessible by right-clicking on the grid column headings and select 
Custom Filter. This method is common to many search grids within MYOB Exo Business. See the 
Exo Business online Help on ExoGrids for more information. 

When a custom filter is active, the funnel icon will appear in the column headings. Select Clear 
Filter to remove the action of the filter. 

Job Overview 

The Job Overview tab of the Job Management screen (see page 51) displays a Gantt chart, 
providing a graphical representation of projects and jobs with their scheduling and resource 
allocations. 

Note: You must set up colours for Job Types (see page 14), Job Statuses (see page 15), and 
Job Categories (see page 18) before using the Job Overview tab. 

 

Job Filters 

The job filters (see page 52) available on the Search tab are also available on the Job Overview 
tab. In addition to these filters, you can also search jobs by date by selecting options under Date 
Search. 

You can hide the job filters to provide more room for the Job Overview chart by clicking the  
button. 
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Job Overview Chart 

The lower section of the Job Overview tab contains two areas: 

• An expanding list of all jobs and projects matching the filtering criteria is displayed on the 
left. Click the plus or minus boxes next to a job or project to expand or collapse the jobs 
underneath it. All projects are displayed first, with jobs that are not assigned to a project 
displayed underneath them. 

• A Gantt chart showing all jobs and projects that match the filtering criteria is displayed on 
the right. 

Projects are represented on the Gantt chart with arrowed bars (  ). 

Jobs are represented as coloured bars. Select a value from the Colour Scheme control to 
determine what the colours will be used to represent - in addition to displaying jobs according to 
the colours set up for their Job Type (see page 14), Job Status (see page 15), and Job Category 
(see page 18), you can also highlight jobs that have alerts or any custom flags enabled. 

Where appropriate, resource allocations (see page 101) are displayed next to job bars. 

Note: The chart does not update automatically as job details are changed. To update the 
chart, you must click Search again. If the Show Job Overview screen needs refresh 
warning User profile setting is enabled, a warning message alerts you when a job has 
changed. To set the chart to update itself at a set interval, configure the Job Cost 
Management Screen Auto Refresh Interval Company profile setting. 

Navigating the Chart 

Use the arrow buttons on the bar at the top of the chart to scroll it left and right 

To change the zoom level of the chart, click the   and  buttons on the toolbar, or drag the 
bar at the top of the chart left (zoom in) or right (zoom out). 

Click the  button to center the chart on the currently selected job/project, and expand it to fill 
the width of the display. 

Click the  button to print a copy of the Gantt chart as it currently appears onscreen. 

Editing Jobs 

Hovering the mouse pointer over a project or job on the Gantt chart displays its details in a popup 
bubble: 
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Jobs can be dragged to change their dates: 

• Click on the left edge of a job bar and drag to change the job s Start Date 
• Click on the right edge of a job bar and drag to change the job s Due Date 
• Click on the center of a job bar and drag to move the Start and Due Dates at once (keeping 

the job s duration the same) 

Note: If resources have been allocated to a job, changing the Start and/or Due Date 
changes the resource allocation dates. 

Double-clicking on a job opens the Job Details window (see page 38), where the job can be 
edited. 

Double-clicking on a project opens the Project Details window (see page 45), where the project 
can be edited. 

Right-Click Options 

Right-clicking on a job or project on the Job Overview tab gives access to the following options: 

• New Job - create a new job (see page 38) 
• New Sub Job - create a new sub job (see page 46) 
• New Duplicate Job - create a new job by copying an existing job (see page 47) 
• Attach to Master Job - assign an existing job as a sub-job of an existing master job 
• Add to Project - add the selected job to a project (see page 45) (and optionally 

create a new project) 
• Remove from Project - removed the selected job from the project it is currently 

assigned to 
• Edit Project Details - edit the details of the selected project 
• Assign Resources - edit the resource allocations (see page 101) for the selected job 

  



MYOB Exo Business Job Costing 

57 

Entering Quote/Budget Information 

To enter quote/ budget information for a job, select the required job and go to the Quote/Budget 
tab. 

 

Field Description 

Group select The first column contains a checkbox that allows you to select the 
line as part of a group of lines to perform actions on using the 
right-click menu. 

Narrative The second column displays the   icon if the line has a narrative 
attached. Right-click on this field and select Add a Narrative to add 
a new narrative to a line. 

A narrative can only be added/edited after the line has been 
saved, using Save or Save & Exit. 

Code A product code. Type ? and press TAB to return a list of products. 
Double click product required. 

Type . (full stop) and press TAB to load Bill of Materials. 

Description A product description. This uses the description of the product as 
entered in the main MYOB Exo Business stock record. It can be 
overwritten. 

Qty The quantity to be supplied. It is 1 by default. 
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Copy to Which tab this transaction will be copied to if the quote becomes 
an actual job. Select from: 

• C - Cost 

• T - Time 

• P - Purchase 

• N - None 

The total quantity of T  type transactions is shown on the bottom 
of the quote tab for easy reference. This is updated when the save 
button is pressed. 

GST No Select the GST number from the predefined list of GST 
entries.  This automatically sets the GST rate. 

Cost The cost of the product. This uses the cost as entered in the stock 
records, but can be overwritten. 

Sell The selling price of the product. This uses the selling price, as 
attached to the customer. It can be overwritten. 

Total Automatically calculated  cannot be directly overridden. 

Markup % This value is automatically calculated, and can be overwritten. 
Enter the percentage amount of the new markup, ignoring the % 
sign e.g. 112.5. 

Status The status of this line. 

Date The date of transaction being entered. 

Cost Type Enter a Cost Type (see page 22), if types are used. Type ? and 
press TAB to select from cost types available. 

Cost Group Enter a Cost Group (see page 20), if groups are used. Type ? and 
press TAB to select from cost groups available. Cost group will 
auto populate if the cost type is entered first, but can be 
overridden. 

Disc (%) Discount applied to the selling price of this line. 

Gross Margin % Automatically calculated  cannot be directly overridden. 

Supplier Name The preferred supplier for any lines that you will need to order in  
for this job. Used when creating purchase orders based on the 
lines that have a copy to  flag set to P  on the quote. 

From Location The preferred location to draw stock from if this quote becomes a 
job. 
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Kit No When a kit (see page 116) is added to the job, the lines of the kit 
are given a kit incidence number that is used to hold the likes of 
the kit together. Lines that are not part of a kit have the value -1. 

Quote Options This works in conjunction with the Quote Options defined in the 
area above the grid.  These are covered in more detail later but 
allow the quote to be split onto sections (say for optional 
upgrades). One quote option is created by default ( Default 
Option ) 

Analysis Codes Analysis Codes are arbitrary codes that can be assigned to 
transactions, allowing you to group them together in various ways 
for sorting and reporting. They do not perform any function 
themselves; they are simply a customisable way of grouping 
related transactions together. 

Labour Allowance This allows a unit labour allowance to be specified associated with 
a product. Labour allowances are distinct from an actual time  
lookup item within the grid and act as a guide. Labour allowance is 
optionally keyed in the labour allowance column and can also be 
defaulted from an extra field on the Stock Item. This is a per unit  
labour value so is multiplied by quantity. The sum of labour 
allowances is also shown at the bottom of the screen. 

 

Total Labour Allowance This is the extended labour allowance and cannot be edited. 

As this tab is an ExoGrid there are more columns available by right clicking on the column header 
and using Select Visible Columns. The columns shown above are shown by default. 

Additional columns that may be selected include: 

Field Description 

Sell Inc GST Sell price including GST 

GST GST value per unit 

GST Total Total line value of GST 

Total Inc GST Line total including GST 

GST Rate The rate of GST 

Length, Width 
and Depth 

Allow additional factors to apply to quantity. These default to 1. 

Total Qty Used with Length, Width and Breadth gives the effective quantity when 
these factors are multiplied by quantity. 
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Line Type This is normally zero but this can indicate: 

1= Kit header 

2=Component 

Kit Code Normally blank but this can contain the BOM code of a kit 

Line # Line number. This can be edited and used with the ExoGrid sorting 
capabilities (or Clarity reporting) to re-sequence the lines from their original 
entry sequence. 

Analysis codes 
1 and 2 

Can be used as another coding for posting to the General Ledger. 

Showline Contains a Y or N to indicate if the line should appear on an invoice. This 
applies to kit component lines where the component lines may be hidden 
(set on BOM header) 

Spread Defaults to Y but can be changed to N.  Indicates if the line will be taken 
into account when using the spread function  to alter the quote total. 

Pref Serial # A single serial number may be selected here if the stock item is serialised 
(see page 119). This pre-assigns the serial to this line of the job. The line 
quantity must be 1. 

Schedule # Billing schedule number when using progress invoicing. 

Clicking Save, Save & Exit, or pressing CTRL + S commits the changes. Clicking Cancel cancels 
changes and returns to the search screen. 

When adding lines, the checkboxes for those lines will not appear until the quote is saved. 

Note: The Quote Tab does not move any stock to Work In Progress. Sending Items direct 
to the Invoice Tab from the Quote Tab will not result in any stock movement. 

Quote Functions 

The functions that are available to be performed on quote lines are detailed below. 

Toolbar Options 

Re-sorting lines  Quote lines can be moved up and down in the order by selecting the line then 
using the Up or Down arrows on the toolbar. This will be saved and re-presented in this order 
once the order is saved. 

Copy  This button allows lines defined in a separate job to be appended to the current job. This is 
useful where perhaps you have other template jobs defined. 

Note: If you are copying serialised lines (see page 119) from another job, you will be given 
the option of pre-assigning serial numbers to them. 
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Change quote total  The   button can be used to alter the quoted values of lines to sum to a 
specified total. The system prompts for the new total. 

 
Lines are proportionally altered by factoring them on the basis of old total versus new total (the 
difference is spread according to the lines original value). If you have some lines which you do not 
wish to be altered by this process then set the value in their Spread column to N. 

Check for Price Changes  Click the  button to check quoted prices against the latest cost and 
selling prices from the stock ledger. A prompt will appear when copying a quote or a job, when 
converting a quote to a job, or manually by pressing the calculator button. 

Check Stock Level  The current levels of stock relating to the requirements of a quotation can be 

checked before it is activated as a job by clicking the  button. This may be useful to help decide 
whether any lines need to be set to be purchased or whether it is expected that stock be taken 
from a particular stock on hand location. 

 

Generate Purchase Order(s)  The   button provides a method of creating purchase orders for 
the job. A list of suppliers from which to purchase services or materials is created, to allow the 
items to be ordered ready for this job to be done once it is accepted. 
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Highlighting the supplier and clicking the Purchase Order button will populate a purchase order 
on the screen ready to be processed. Lines can be added or removed from this purchase order, or 
even a different supplier may be selected if preferred.  Each line ordered will be stamped with the 
current Jobcode so that when the goods arrive they will be transferred directly to the job as soon 
as they are costed via the Inwards Goods functions. 

Convert Quote  The Convert Quote to Actual Cost and Convert Quote to Invoice options allow a 
job to be activated when a quote is accepted, and to create the necessary stock movements into 
work in progress. 

This function assumes that there is adequate stock available and will push the quantities into 
negative if there isn t. It also has the option of invoicing these Cost transactions immediately. If the 
option to exclude stock from work in progress is enabled, then it will also be possible to transfer 
transactions directly from the quote tab to the invoice tab without making the stock movements 
that would normally be associated with them. 

Note: If any of the lines to be converted contain serialised or batch-tracked stock items, 
they must be converted to actuals before they can be converted to an invoice. 

Quote Options 

 
By default, all lines of a job belong to the DEFAULT OPTION, which is automatically created for 
each job. When quoting, it may also be preferable to include additional lines for optional extras or 
upgrades to the default being quoted. 

To create or maintain one or more additional Quote Options click the Setup button. A search 
screen of additional Quote Options will be displayed. For a new job where additional options have 
not yet been created, there will be no entries. 
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To create a new option click New. To edit an existing, option double-click its entry. 

The name of the option can be set or maintained. 

For each line on the Quote/Budget tab, the Quote Option column can be changed from the 
DEFAULT OPTION. 

Note: For kits/bills of materials, the Quote Option set for the kit header is copied to all kit 
lines. Options cannot be set for kit lines individually. 

Ticking or unticking a Quote Option in the header panel will include/exclude that option from the 
job totals at the bottom of the screen. 

The Quote Options can also be used in Clarity reporting to provide alternate quoted options 
within the single job. 

Right-click Menu Options 

Right-clicking on a quote/budget line will show options relevant to line, such as copying specific 
lines to the Timesheet, Cost, or direct to the Invoice tab. These options change depending on the 
characteristics of the current line. 

Some of these are common with the toolbar actions detailed above. 

Send line to  For a line which has not been moved to another tab (i.e. the Copy to field is set to 
N ) the system offers: 

• Send Line to Cost Page 
• Send Line to Timesheet 
• Send Line Direct to Invoice 

These can be used to send the line to the Costs (see page 73), Timesheets (see page 65) or Invoice 
(see page 81) tabs respectively. The first two of these actions are equivalent to selecting C  or T  
for the Copy to field. 

Split line  This allows a line that has a quantity > 1 to be split into two lines so that they can be 
acted upon independently. The system will prompt for the quantity to be split-off into the new 
line: 

 
The remainder of the quantity will be left on the original line. 

Mark for purchase (CTRL+P)  This is the same action as changing the Copy to field to P . 

Add Narrative (CTRL+N)  This allows a line level narrative to be added to or edited for a line. A 
narrative editing window is opened with blank or previously entered text. Right clicking in the text 
area provides additional options for inserting text: 

• Insert Common Phrases works in the same way as for the job header (see page 43). 
• Insert Stock Notes copies the content of the Notes tab from the Stock Item setup screen. 
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Attach line to kit  At least one kit must exist on the job before this function can be used. When 
selected a search screen of kit headers on the job appears so that you can select which kit the line 
is to be appended to. The line will be re-sequenced if necessary and added as the last line of the 
kit. 

Remove Line (CTRL+DEL)  This deletes the current line from the job.  A confirmation request is 
displayed. 

Kit Functions 

There are a number of kit functions (see page 117) which may be used when creating a quote. 

Marked Lines 

The functions under Marked Lines on the right-click menu operate on the lines which have 
checkboxes ticked. All lines can be ticked/unticked by clicking the checkbox in the column header 
row. The Marked Lines submenu contains the following options: 

Set Markup %  This function prompts for a markup percentage and adjusts the sell prices of the 
selected lines accordingly. 

Set Gross margin %  This function prompts for a gross margin percentage and adjusts the sell 
prices of the selected lines accordingly. 

Set Cost Types  This function pops a combo box dialogue where the user can select a cost type to 
apply to the selected lines. 

Set Cost Groups  This function pops a combo box dialogue where the user can select a cost group 
to apply to the selected lines. 

Attach to Kit  Adds the selected lines to an existing kit on the job. 

Send to Cost Page  This function marks the selected lines to Copy to = C to send them to the Costs 
tab. 

Send to Timesheet  This function marks the selected lines to Copy to = T to move them to the 
Timesheet tab. 

Send Direct to Invoice  This function sends the selected lines directly to the invoice tab. 

Generate Billing Schedule  This function is only selectable if the progress/contract billing option is 
active. This is an advanced feature that is not in the base Job Costing package. When used, this 
function creates a new progress billing schedule containing the selected lines. A window appears 
for the user to enter a billing code and description for the billing schedule. 

Append to Billing Schedule  This function adds the selected lines to an existing progress billing 
schedule. 

Remove from Billing Schedule  This function removes the selected lines from the progress billing 
schedule they have already been added to. 

Remove All Marked Lines  Deletes the selected lines from the job. 
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Entering Time Costs 

There are two modes of entering the actual time amount on both the Job Management and 
Direct Time Entry (see page 68) windows. 

• Hours Only 
• Hours Calculated from Start and End Times 

This setting is controlled by the Calculate Hours  from Start  and End  times in timesheet entry 
user-level profile setting (see page 33). If this setting is not enabled, the amount of time can be 
entered directly. In this case, the start and end dates and times must be entered, and the amount 
of time is calculated from these. The hours can still be edited and do not have to agree. If you 
want to enter date and end dates and times, then you will need to make these fields visible on 
time entry grids in the appropriate column order. 

Note: The Start date is the equivalent of Transaction date on the Cost tab (see page 73).  

Select the Timesheets tab: 

 
There are various filter checkboxes at the top of the screen: 

• Ready to Invoice 
• Work in Progress 
• Invoiced 
• Cancelled 
• Written-off 
• Hide Kit Components 

Only the Work in Progress filter is enabled by default. 
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Field Description 

Group select The first column contains a checkbox that allows you to select the line as 
part of a group of lines to perform actions on using the right-click menu. 

Narrative The second column displays the   icon if the line has a narrative 
attached. Right-click on this field and select Add a Narrative to add a 
new narrative to a line. 

A narrative can only be added/edited after the line has been saved, 
using Save or Save & Exit. 

Staff Name An employee name. If unknown type ? and press TAB to search for the 
employee. Double-click on the correct name. 

Code A code for the type of labour. 

Details The description recorded in the stock records will be the default entry 
here. It can be over written with a more detailed description of the job. 

Cost The cost of the labour. This uses the cost as entered in the stock records. 
It can be overwritten. 

Sell The selling price of the labour. This uses the selling price of the product 
as entered in the stock records. It can be overwritten. 

Sell in GST The selling price of the labour including GST 

Start date The date the work was started. Enter as ddmmyy e.g. 210800. The entry 
is automatically changed to 21.08.2000. 

Start time The time the work was started. 

End date The date the work was completed. Enter as ddmmyy e.g. 210800. The 
entry is automatically changed to 21.08.2000. 

End time The time the work was completed. 

Hours The number of hours worked. Part hours are entered in decimals not 
minutes e.g. 2½ hours = 2.5 not 2.30. (Automatically calculated if start and 
end times are enabled.) 

Total This value is automatically calculated. 

GST GST value per unit. 

GST Total Total line value of GST. 

Total Inc GST Line total including GST 
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Mark up % This value is automatically calculated, but can be modified by line  this 
adjusts the selling price accordingly. 

A default markup can be applied for direct purchases via the Cost Types 
(see page 22). This can be overwritten but deals well with one-off 
purchases or subcontracted services where the cost price and charge-
out vary each time. 

Status The status of this line. Will be one of: 

• C  Committed. The stock has been committed to Work in 
progress. 

• R  Ready to be invoiced. 

• I  Invoiced. The line can no longer be edited. 

• X  Cancelled line. If the stock item is material it will be taken from 
work-in-progress and returned to the stock count. It will add no 
cost to job and no sell price. Serial numbers will be unassigned. 

• W  Writes item off. This will remain in WIP and be considered a 
cost to the job. It will not add to selling price of the job. Serial 
numbers will be remain assigned. 

Cost Type Enter a Cost Type (see page 22), if types are used. Type ? and press TAB 
to select from cost types available. 

Cost Group Enter a Cost Group (see page 20), if groups are used. Type ? and press 
TAB to select from cost groups available. Cost group will auto populate if 
the cost type is entered first, but can be overridden. 

GST No Select the GST number from the predefined list of GST entries. This 
automatically sets the GST rate. 

Disc (%) Discount applied to the line. 

Gross Margin % Display field only  cannot be used to work-back the selling price on this 
line. 

Analysis codes 1 
and 2 

Can be used as another coding for posting to the General Ledger. 

Source Ref An optional reference number. 

Invoice Date   

Line # Line number. This can be edited and used with the ExoGrid sorting 
capabilities (or Clarity reporting) to re-sequence the lines from their 
original entry sequence. 

Showline Contains a Y or N to indicate if the line should appear on an invoice. This 
applies to kit component lines where the component lines may be 
hidden (set on BOM header). 
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Spread Defaults to Y but can be changed to N.  Indicates if the line will be taken 

into account when using the spread function  to alter the quote total. 

Schedule # Billing schedule number when using progress invoicing. 

Allowance This allows a unit labour allowance to be specified associated with a 
product. 

Click Save to save data or Cancel to lose all entries made. 

Timesheet Workflow 

The natural flow of statuses for transactions is: 

1. C - Committed 

2. R - Ready to invoice 

3. I - Invoiced 

Committed transactions represent work in progress. 

Ready to Invoice transactions are those that have been pushed  onto the invoice tab but have 
not yet been invoiced. These are also work in progress. 

Invoiced transactions are no longer editable. They have either appeared as a line on a Debtors 
Invoice, or have been part the cost of a product re-introduced into stock on hand. 

To move a line to another status, right click on the line and select the appropriate action. You can 
click the Send All to Invoice button to send all lines to the Invoice tab (see page 81). 
 
You may action multiple lines by ticking then and using the Marked Lines entry from the right-click 
menu. 

Narratives 

Any transaction line can have notes attached. These will be taken through and can be printed on 
the invoice as required. Right-click on the line and select Add Narrative to attach a narrative to a 
line. To remove a narrative, delete the existing text. 

  



MYOB Exo Business Job Costing 

69 

Direct Time Entry 

This screen is used to efficiently enter chargeable time spent on jobs, when data entry is done for 
timesheets are provided covering multiple jobs, rather than individual job sheets. The Direct Time 
Entry method is employee-centric  and is often used when employee or resource timesheets are 
used listing the times for multiple jobs. 

Select Transactions > Direct Time Entry from the main Job Costing menu. The following screen 
appears: 

  

Note: Because Job Code and Account number are linked, entering data in any one of these 
fields causes the others to be filled in automatically. 

Field Description 

Job Code The job code. Enter ? and press TAB to select the number if unknown. 

Title The job title. This fills automatically on entry of job code. 

Account This fills automatically on entry of job code. You can make this field 
invisible or move it out to the right as you choose. 

Staff Name The resource name. Enter ? and press TAB to select the number if 
unknown. 

Code The code. Enter ? and press TAB to select the number if unknown. 

Details Brief details of work carried out to be typed in. 

Start Date The date the work was started. Enter as ddmmyy e.g. 210800. The entry is 
automatically changed to 21.08.2000. 

Start Time The start time. Enter two digits for hours and two digits for minutes. 
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End Date The date the work ended. Enter as ddmmyy e.g. 210800. The entry is 
automatically changed to 21.08.2000. 

End Time The end time. Enter two digits for hours and two digits for minutes. 

Hours The number of hours worked. Part hours are entered in decimals not 
minutes e.g. 2½ hours = 2.5 not 2.30. (Automatically calculated if start and 
end times are enabled). 

Cost Enter the hourly rate cost to the business. 

Rate Enter the charge rate to the customer. 

Total This value is calculated automatically. 

Cost Type Enter a Cost Type (see page 22), if types are used. Type ? and press TAB 
to select from cost types available. 

Cost Group Enter a Cost Group (see page 20), if groups are used. Type ? and press 
TAB to select from cost groups available. Cost group will auto populate if 
the cost type is entered first, but can be overridden. 

Disc (%) Discount applied to the line. 

Source Ref An optional reference number. 

Batch Code An optional code to group batches of transactions. 

Total Cost This value is calculated automatically. 

Analysis Codes Analysis Codes are arbitrary codes that can be assigned to transactions, 
allowing you to group them together in various ways for sorting and 
reporting. They do not perform any function themselves; they are simply a 
customisable way of grouping related transactions together. 

Serviceable Unit To assign a serviceable unit (see page 104) to a job, enter the code for the 
serviceable unit in this column. Type ? and press TAB to select from a list 
of available serviceable units. 

Check that all the information entered is correct, then click Save to save the data, or Cancel loses 
all entries made. 

Toolbar Buttons 

Buttons on the toolbar can assist in the data entry: 

New Line copies from line above  Toggle the  button on for line duplication. In this mode, 
pressing TAB for a new line will copy the entry in the line immediately above. It can then be over 
written with changes. 

Default Date  Defaults to today s date. Click and use the drop down calendar to choose another 
default date. 
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MYOB Exo Payroll Integration 

MYOB Exo Job Costing has the ability to record timesheet data against a specific job. This data 
can then be exported into MYOB Exo Payroll. 

Setting up Exo Payroll Integration 

In order for the Exo Payroll integration features to be available, the following company-level 
profile settings must be configured: 

• Integrate timesheets with PayrollEnterprise - this setting must be enabled. 
• PayrollEnterprise export location - this must be set to the root directory of the Exo Payroll 

installation, e.g. C:\Payrollv. 
• PayrollEnterprise Database Location - this must be set to the database directory of the Exo 

Payroll installation, e.g. C:\Payrollv\DATABASE. 

In addition, the FoxPro ODBC driver must be installed on the MYOB Exo Business server. This 
driver is installed automatically by the Installation Wizard; if the wizard was not used to install Exo 
Business, this driver must be installed manually. The driver is available on the Exo Business CD. 

Finally, ensure that all staff members who will have timesheet data recorded against them are set 
up in both the Exo Business and Exo Payroll systems. Ensure all that Exo Business staff members 
have their Exo Payroll Employee Code entered into their Employee ID (Payroll) field.  This 
property, located on the Authority tab in the Staff > Users section of the Exo Business 
Configurator, links the staff member to their corresponding employee entry in the Exo Payroll 
system.   

Entering Payroll Information 

The following additional fields are available on the Timesheets tab (see page 65) when payroll 
integration is enabled: 

Field Description 

Ready for Payroll A tick box indicating that the line item is ready to be posted to Exo 
Payroll. Once the line item has been posted, this property displays P . 

Payroll Hours The number of hours to be sent to Exo Payroll. This value defaults to the 
value of the existing Hours column, but it can be changed to any value. 

Pay Rate The pay rate multiplier that applies to the overall amount, e.g. Ordinary , 
Time & Half . The available options are imported from Exo Payroll. 

Wage Code The wage code that represent s the employee s hourly rate. This value 
defaults to the employee s default Wage Code from Exo Payroll, but it 
can be edited. 

Cost Centre The cost centre related to the payroll expense. This value defaults to the 
employee s default cost centre from Exo Payroll, but it can be edited. 

Note: If a timesheet line is set to Ready to Invoice , its Ready for Payroll property is ticked 
automatically. This property can be unticked manually if necessary. 
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Exporting Timesheets 

The Post TimeSheets to Payroll menu item is available to export the timesheet data in a format 
that can then be imported into Exo Payroll. Selecting this menu item opens the following window: 

 
This screen displays all timesheet lines whose Ready for Payroll property is ticked. Lines can be 
unticked to remove them from the posting if necessary. 

Clicking OK posts all selected timesheet lines to a CSV file in the location specified by the 
PayrollEnterprise export location profile setting. This file can then be imported into Exo Payroll 
using that program s Import Time Transactions function. 

Importing Timesheets into Exo Payroll 

Timesheet data is imported into Exo Payroll using the existing import functionality. 

Select Import Time Transactions from the Pay menu of PayrollEnterprise and the timesheet data is 
automatically imported. 

Note: In order for this menu option to be available, the Import time transactions option on 
the Payroll Setup window must be ticked, and the CSV file  option must be selected 
for Format. 
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Entering Costs 

Select the Costs tab. 

 

Field Description 

Group select The first column contains a checkbox that allows you to select the 
line as part of a group of lines to perform actions on using the 
right-click menu. 

Narrative The second column displays the   icon if the line has a narrative 
attached. Right-click on this field and select Add a Narrative to add 
a new narrative to a line. 

A narrative can only be added/edited after the line has been 
saved, using Save or Save & Exit. 

Code A product code. Enter ? and press TAB to select the number if 
unknown. 

Description A product description. This uses the description of the product as 
entered in the stock records. It can be overwritten. 

Quantity The quantity to be supplied. The default is 1. 

Cost The cost of the product. This uses the cost as entered in the stock 
records. It can be overwritten. 
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Sell The selling price of the product. This uses the selling price of the 
product as against the customer. It can be overwritten. 

Status The status of this line. Will be one of: 

• C  Committed. The stock has been committed to Work in 
progress. 

• R  Ready to be invoiced. 

• I  Invoiced. The line can no longer be edited. 

• X  Cancelled line. If the stock item is material it will be 
taken from work-in-progress and returned to the stock 
count. It will add no cost to job and no sell price. Serial 
numbers will be unassigned. 

• W  Written off. This will remain in WIP and be considered 
a cost to the job. It will not add to selling price of the job. 
Serial numbers will be remain assigned. 

Total This value is automatically calculated. 

Date The date cost was incurred. 

GST No Select the GST number from the predefined list of GST entries. 
This automatically sets the GST rate. 

Disc (%) Discount applied to the selling price of this line. 

Mark up % This value is automatically calculated, but can be edited. On 
starting to type new entry a small screen pops up. Enter the 
number for the new markup, ignoring the % sign e.g. 112.5, click 
OK to confirm or Cancel to return to screen without making a 
change. 

Invoice date Date of last invoice. 

Kit No When a kit (see page 116) is added to the job, the lines of the kit 
are given a kit incidence number that is used to hold the likes of 
the kit together. Lines that are not part of a kit have the value -1. 

Line # Line number. This can be edited and used with the ExoGrid sorting 
capabilities 9or Clarity reporting) to re-sequence the lines from 
their original entry sequence. 

Source Ref An optional reference number. 

Serviceable Unit If the line relates to a serviceable unit (see page 104), enter the 
unit s code here. 

WIP Out Date The date and time when the cost was moved out of Work in 
Progress, e.g. when it was sold or written off. 
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Labour Allowance This allows a unit labour allowance to be specified associated with 
a product. 

Total Labour Allowance This is the extended labour allowance and cannot be edited. 

Cost Type Enter a Cost Type (see page 22), if types are used. Type ? and 
press TAB to select from cost types available. 

Cost Group Enter a Cost Group (see page 20), if groups are used. Type ? and 
press TAB to select from cost groups available. Cost group will 
auto populate if the cost type is entered first, but can be 
overridden. 

To WIP This value cannot be changed here. 

As this tab is an ExoGrid there are more columns available by right clicking on the column header 
and using Select Visible Columns. The columns shown above are shown by default. 

Additional columns that may be selected include: 

Field Description 

Sell Inc GST Sell price including GST. 

From loc Enter a number indicating the From location or type ? and press TAB to 
search for location and double-click to select. 

To Location WIP is locked. No entry can be made in this screen. 

Total Cost This value is automatically calculated. 

GST GST value per unit. 

GST Total Total line value of GST. 

Total Inc GST Line total including GST 

Staff Name An employee name. If unknown type ? and press TAB to search for the 
employee. Double-click on the correct name. 

Length, Width 
and Depth 

Allow additional factors to apply to quantity. These default to 1 

Total Quantity Used with Length, Width and Breadth gives the effective quantity when 
these factors are multiplied by quantity. 

Analysis codes 
1 and 2 

Can be used as another coding for posting to the General Ledger. 

Total Quantity Used with Length, Width and Breadth gives the effective quantity when 
these factors are multiplied by quantity. 
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Showline Contains a Y or N to indicate if the line should appear on an invoice. This 
applies to kit component lines where the component lines may be hidden 
(set on BOM header). 

Spread Defaults to Y but can be changed to N.  Indicates if the line will be taken 
into account when using the spread function  to alter the quote total. 

Schedule # Billing schedule number when using progress invoicing. 

Click Save to save the data, or Cancel loses all entries made. 

Toolbar Options 

Send All to Invoice  Send all lines to the Invoice tab (see page 81). 

Re-sorting Lines  Quote lines can be moved up and down in the order by selecting the line then 
using the Up or Down arrows on the toolbar. This will be saved and re-presented in this order 
once the order is saved. 

Copy  This button allows lines defined in a separate job to be appended to the current job. This is 
useful where perhaps you have other template jobs defined. 

Note: If you are copying serialised lines (see page 119) from another job, you will be given 
the option of pre-assigning serial numbers to them. 

Right-click Menu Options 

Right-clicking on a quote/budget line will show options relevant to line, such as copying specific 
lines to the Timesheet, Cost, or direct to the Invoice tab. These options change depending on the 
characteristics of the current line. 

Send Line to Invoice/Send All to Invoice  These options allow you to send the selected line, or all 
lines, to the Invoice tab (see page 81). 

Split Line  This allows a line that has a quantity > 1 to be split into two lines so that they can be 
acted upon independently. The system will prompt for the quantity to be split-off into the new 
line: 

 
The remainder of the quantity will be left on the original line. 

Add Narrative (CTRL+N)  This allows a line level narrative to be added to or edited for a line. A 
narrative editing window is opened with blank or previously entered text. 

Cancel Line  If the stock item is material it will be taken from work-in-progress and returned to the 
stock count. It will add no cost to the job and no sell price. Serial numbers will be unassigned. 

Write-off Line  Writes the line item off. This will be considered a cost to the job. It will not add to 
selling price of the job. Serial numbers will remain assigned. 

UnWrite-off  For lines that have been written off, this option generates new stock transactions to 
reverse the write off transactions and returns the stock item to WIP. 
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Move Line to Another Job  Moves the line item from one job to another. There are some 
constraints on moving lines: 

• The stock item for the line must not be serialised item. 
• The jobs must have the same currency. 
• The source or destination job must not be read-only. 
• The line must not be a kit component. 

When this option is selected, a search window appears, from which the user selects the 
destination job. The changes to both jobs are automatically saved. The source job window 
remains open. 

Attach Line to Kit  Adds the line item to a selected kit (Bill of Materials). At least one kit must exist 
on the job before this function can be used. 

Direct Material Entry 

This screen allows you to input any stock items used in jobs, across multiple jobs at once. The Job 
Management screen (see page 73) method is used if the time entry is job-centric . The Direct 
Material Entry method is materials- or costs-centric , because costs can be allocated against a 
number of jobs without having to change screens. 

Select Transactions > Direct Material Entry from the main Job Costing menu. 

 

Field Description 

Job Code The job code. Enter ? and press TAB to select the number if unknown. 

Title The job title. This fills automatically on entry of job code. 

Account This fills automatically on entry of job code. You can make this field 
invisible or move it out to the right as you choose. 

Stock Code The Stock Code. Enter ? and press TAB to select the number if unknown. 
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Description A description of the stock. As the description relates to the stock code, no 
entry is required here. You may accept the default entry or edit it. 

Qty The quantity used. 

Cost The cost of a single item. Entering the stock code may have generated an 
entry. However the entry may be over written. 

Sell The sale price of a single item. Entering the stock code may have 
generated an entry. However the entry may be over written. 

Markup (%) No entry as it is automatically calculated. This can be overwritten. On 
starting to type new entry a small screen pops up. Enter the number for 
the new markup, ignoring the % sign e.g. 112.5, click OK to confirm or 
Cancel to return to screen without making a change. 

Total This value is calculated automatically. 

Cost Type Enter a Cost Type (see page 22), if types are used. Type ? and press TAB 
to select from cost types available. 

Cost Group Enter a Cost Group (see page 20), if groups are used. Type ? and press 
TAB to select from cost groups available. Cost group will auto populate if 
the cost type is entered first, but can be overridden. 

GST No Select the GST number from the predefined list of GST entries. This 
automatically sets the GST rate. 

Disc (%) Discount applied to the selling price of this line. 

Total Quantity Used with Length, Width and Breadth gives the effective quantity when 
these factors are multiplied by quantity. 

Source Ref An optional reference number. 

Batch Code An optional code to group batches of transactions. 

Gross Margin % This value is calculated automatically. 

Analysis Codes Analysis Codes are arbitrary codes that can be assigned to transactions, 
allowing you to group them together in various ways for sorting and 
reporting. They do not perform any function themselves; they are simply a 
customisable way of grouping related transactions together. 

Serviceable Unit To assign a serviceable unit (see page 104) to a job, enter the code for the 
serviceable unit in this column. Type ? and press TAB to select from a list 
of available serviceable units. 

Check that all the information entered is correct, then click Save to save the data, or Cancel loses 
all entries made. 
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Toolbar Buttons 

Buttons on the toolbar can assist in the data entry: 

New Line copies from line above  Toggle the  button on for line duplication. In this mode, 
pressing TAB for a new line will copy the entry in the line immediately above. It can then be over 
written with changes. 

Clear Grid  Click the   button to clear all information entered on this screen. 

Default Date  Defaults to today s date. Click and use the drop down calendar to choose another 
default date. 

Entering Purchase Orders 

Select the Purchases tab. The following screen is displayed: 

 
This tab is used for job-specific purchases. To make a general purchase for the business, select 
Transactions > Purchase Orders Screen from the main Job Costing menu. 

The purchase order tab is split into four sections. The life cycle of a purchase order runs bottom to 
top. 

Section Description 

Invoiced Goods that have been invoiced by the supplier (final costs). 

Costed awaiting invoice Costed awaiting invoice. The goods are in stock but the 
suppliers invoice is outstanding. Purchase costs may have been 
estimated. 
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In store waiting costing Shows inwards goods receipts that have not yet been costed. At 
this stage no stock transactions have been written for the 
receipt therefore the goods do not show as being in stock. 

Ordered awaiting delivery These are outstanding purchase orders. 

Right-click menus for each section can be used to: 

• View the Purchase Order history 
• Receipt a purchase order by creating an Inwards Goods Receipt. 
• Cost a previous receipt and move goods into store. 

Double-clicking a line in all but the top grid will drill to the purchase order screen for that line. 

Double-clicking a line in the top grid will display the invoice. 

Click Save to save the data, or Cancel to lose all entries made. 

New Purchase Orders 

To enter a new Purchase Order from the Purchases tab, click the Purchase Order button or press 
F8. Alternatively, purchase orders can be generated based on information entered into the quote 
tab for this job. 

To enter or edit Purchase Orders from the main Job Costing screen, select Transactions > 
Purchase Orders Screen. 

 
See the MYOB Exo Business online Help for information on creating Purchase Orders. 
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Generating Invoices 

There several workflows that may be used for invoicing: 

• Lines can be flagged as ready for invoice and then pending lines of a job invoiced. 
• Cost lines can be sent directly to the invoice tab for invoicing. 
• Optionally, progress billing may be activated and lines sent to a billing schedule within the 

job.  Multiple schedules may exist within a job. 

Select the Invoice tab. The following screen is displayed: 

 
By default the filters on the Invoice tab are set to show only Ready for Invoice  lines. The lines 
must be flagged with this status for them to appear. If the job is a master job, an Include Sub Job 
Lines filter is available to display lines from the job s sub jobs. 

Note: If changes or additions are made in the Exo Business Invoices screen they will not be 
reflected on the job invoice. Ensure everything to be associated with the job is added 
via the Job Costing module. 

Field Description 

Group select The first column contains a checkbox that allows you to select the line as 
part of a group of lines to perform actions on using the right-click menu. 
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Narrative The second column displays the   icon if the line has a narrative 
attached. Right-click on this field and select Add a Narrative to add a new 
narrative to a line. 

A narrative can only be added/edited after the line has been saved, using 
Save or Save & Exit. 

Code 
Description 
Quantity 
Cost 
Sell 

These values are carried forward to this tab from the tab they were 
created on. However, values can be over-written and any changes will be 
reflected on the original tab. 

Total cost This value is automatically calculated, and updates to reflect any changes 
made in other fields. 

Total This value is automatically calculated, and updates to reflect any changes 
made in other fields. 

Disc (%) Discount applied to the selling price of this line. 

Mark up This value is automatically calculated, but can be edited. On starting to 
type new entry a small screen pops up. Enter the number for the new 
markup, ignoring the % sign e.g. 112.5, click OK to confirm or Cancel to 
return to screen without making a change. 

Status The status of this line. Will be one of: 

• C  Committed. The stock has been committed to Work in 
progress. 

• R  Ready to be invoiced. 

• I  Invoiced. The line can no longer be edited. 

• X  Cancelled line. If the stock item is material it will be taken from 
work-in-progress and returned to the stock count. It will add no 
cost to job and no sell price. Serial numbers will be unassigned. 

• W  Written off. This will remain in WIP and be considered a cost 
to the job. It will not add to selling price of the job. Serial numbers 
will be remain assigned. 

Invoiced Shows previously invoiced amounts. 

Start Date 
Invoice Date 

These values are read-only. 

GST No 
Gross Margin % 
Source Ref 
Line No 

These values are copied from the Quote tab (see page 57). 

Batch Code An optional code to group batches of transactions. 

Schedule # Billing schedule number when using progress invoicing. 
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Supplied Displays either Y  or N  to indicate whether the line item has been 
supplied. Can be altered by right-clicking on the line and selecting Toggle 
Supplied Flag. 

Analysis Codes Analysis Codes are arbitrary codes that can be assigned to transactions, 
allowing you to group them together in various ways for sorting and 
reporting. They do not perform any function themselves; they are simply a 
customisable way of grouping related transactions together. 

Changing the Invoice Total Amount 

The Change Invoice Total button (   ) can be used to make the invoice total equal what the 
customer is expecting. This will effectively spread the additional markup (or markdown) across all 
of the lines on the invoice, proportionally by value. The advantage of this approach is that you get 
a truer representation of actual profitability by line, than by using an additional markup/markdown 
line on the invoice. 

This feature can also be useful where the Job is to be billed at a contract rate that may be in no-
way related to the actual sum of transactions being invoiced. 

Invoicing the Job 

Invoicing the job is the final step. After checking that all entries are correct, click the Invoice Job 
button in the main toolbar. 

Note: The Invoice Job button dropdown includes an option to Check Alerts, which displays 
a window detailing any problems that will prevent the job from being invoiced. 

The system passes the invoice data to the Invoice Entry window, using the pricing information 
from the job. 

 
Click Save to save the data, or Cancel to lose all entries made. 
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Invoicing Sub Jobs from a Master Job 

If the selected job is a master job, the Invoice Job button includes an Invoice Job with Sub Jobs 
option: 

 

• Clicking Invoice Job generates an invoice for the master job only. 

• Clicking Invoice Job with Sub Jobs generates a single consolidated invoice for the master 
job and all of its sub jobs. 

Note: In order for this menu option to be available, the Allow invoicing of sub jobs from 
master jobs Company-level profile setting (see page 30) must be enabled. 

When Invoice Job with Sub Jobs is clicked, a list of all sub jobs is displayed: 

 
Any jobs that cannot be invoiced are highlighted in red. Jobs that have their Invoice via Master 
Job option unticked are greyed out. When a highlighted job is selected, the reasons why it cannot 
be invoiced are displayed at the bottom of the window. 
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Click Start Process to generate the consolidated invoice. The details of the master job are 
displayed in the header: 

 
The Job Code column indicates which sub job each line applies to. 

Completing and Closing a Job 

A job can continue indefinitely and generate any number of invoices. However many people 
choose to close  a job after an invoice has been generated and all outstanding lines have been 
resolved by having been invoiced, converted into an asset, written-off or cancelled as appropriate. 
There is no COMPLETE status by default. You define one or a number of complete statuses of 
your own naming. A complete status is one that has the Jobs are complete option ticked. 

Editing Job Invoices 

Job invoices can be edited after they have been saved, even after the job has been 
completed.  Job invoices are edited in the same way as other Debtor invoices: right-click on the 
invoice on the Transactions tab of the Debtor Account Details window and select Edit Job Invoice 
to open the Edit Invoice window. 

After making any edits to the invoice on a completed job, the system opens a window giving the 
option to change the job out of the Completed  status. 

Restrictions 

The ability to edit job invoices is controlled by the Permitted level of access to debtor transaction 
editing User-level profile setting. This must be set to Full invoice editing allowed  for users to be 
able to edit job invoices at the line level. 
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Regardless of the profile setting, an invoice cannot be edited if any of the following conditions 
apply: 

• The invoice contains serialised stock items 
• The invoice contains batch-tracked items 
• The invoice has already been posted to the General Ledger 
• The invoice is from a prior period 

Editing Job Invoice Line Details 

Users can edit selected details of each invoice line; the stockcode and quantity cannot be 
changed, but all other details are available for editing. This includes the item description, price and 
discount on each line. 

Note: While users cannot change a line s stockcode, it is possible to delete the line and add 
a new one with the new stockcode - see below. 

Deleting Job Invoice Lines 

Users can delete lines off a job invoice in the usual way - select the line and press the DELETE key. 
Deleting a line reverses the stock movement for that line, meaning that the stock item is returned 
to Work In Progress. This change is reflected in the job that the invoice originated from; the status 
of the relevant line is set back to Ready to Invoice  on the Costs and Invoice tabs of the Job 
Details window. 

Adding Lines to a Job Invoice 

Users can add lines to a job invoice in the usual way - press the down arrow to add a new line 
then enter the detail. Adding a line to a job invoice creates a new transaction with the default 
stock location, not the job s location. 

The new line is visible on the invoice if you view it from the Billing Schedule tab of the Job Details 
window, but it does not appear on the Costs or Invoice tab. 

Crediting Job Invoices 

User can also credit job invoice by right-clicking on them and selecting Generate Credit for Job 
Invoice. When crediting a job invoice, users can edit line descriptions, but not stockcodes, quantity 
prices or discounts. 

As with invoice editing, users can now remove lines from the credit, so that only some of the 
invoice is credited. 

Creating Assets 

Some businesses may have jobs or projects that create products of value that are not invoiced 
directly to the customer, but instead create stock of value that can be sold via Debtors Invoicing or 
Sales Order entry. Other businesses may use Job Costing to track the cost of maintaining an asset 
or may be creating an asset as part of the job. An example of this might be a boat builder using 
labour and materials to create a mould. 
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The Create Asset button on the toolbar of the Invoice tab (see page 81) is used to group the 
individual lines on an invoice into a stock item. The stock item must exist first before the lines can 
be grouped. There are additional choices by clicking the small down arrow to the right of the 
button. The default action is Create Single Asset. 

 
Note: This feature is useful when the end result is a product to be returned to stock, or 

when an invoice for services is to be sent to a client, but the client does not need the 
details of the amount, only the total amount. 

Creating a Single Asset 

Click the Create Asset button or select the Create Single Asset option. The Create Stock Item/ 
Asset window appears: 

 
If the stockcode is known enter it. If it is not known, type ?, then press TAB to search for it. If it has 
not been created, click New. 

Note: See the MYOB Exo Business online Help For more information on stock items and 
their creation. 
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Creating Multiple Assets 

The Create Multiple Assets option allows you to create multiple stock items as assets. 

 
Enter stock codes in the Code column. For each stock item added, the quantity and unit cost 
columns are editable. The OK button is disabled until the sum of the extended costs matches the 
Total cost to distribute at the bottom of the window. This cost is the sum of the costs on the main 
job screen. 

Creating Assets from Output Items 

The Create Assets from Output Items option pre-populates the Create Stock Item/Asset window 
with the Output Items sub-tab (see page 44) of the main job details screen. This will be either the 
single item window if only one item is pre-populated or the multiple items window if there is more 
than one. 

  



MYOB Exo Business Job Costing 

89 

Batch Invoicing 

You can generate invoices for all lines marked Ready to Invoice  in a single operation, using the 
Batch Job Invoicing function. Run the batch invoicing function by selecting the Batch Job 
Invoicing menu option. 

Note: If this menu option is not available, you may need to add it at Setup > Menu 
Designer. 

 
Note: If the If the Allow invoicing of sub jobs from master jobs Company-level profile 

setting (see page 30) is enabled, the option Invoice sub jobs from master job is 
available at the top of the window. Ticking this option means that for each master 
job, a single invoice will be generated for the master job and all of its sub jobs. If the 
option is not ticked, a separate invoice is generated for each sub job. 

Searching Jobs 

The top section of the Batch Job Invoicing window contains the job filters (see page 52) available 
on the Search tab of the Job Management Screen. 

Set filters as necessary, then click Search to display all jobs that match the filter options, and that 
have lines that are set to the Ready to Invoice  status. 

The tick boxes next to each box can be checked or cleared to include or exclude the job from the 
invoicing process. 
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Double-clicking on a job displays the individual lines of the job: 

 
Only lines with the status Ready to Invoice  are displayed. If there are any problems with the job 
that mean it cannot be invoiced, these are displayed at the bottom of the window. 

Click the Goto Job button to open the Job Details window to view all information about the job. 

Click the PreAlloc Serial Nos button to assign serial numbers to the job. 

Check or clear the Selected option to include or exclude the job from the invoicing process. 

Processing Invoices 

To begin processing the selected invoices, click the Start Process button. 
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Specify the following details: 

Field Description 

Invoice 
Date 

Enter the date for all invoices in the batch 

Age Select the period that the invoices will be assigned to. 

Freight Select how freight charges will be applied. Choose from: 

• Same charge for all invoices - Enter the amount that will be charged to 
all invoices. 

• Let me apply charges to individual invoices - The next window will let 
you enter individual amounts for each invoice. 

• No freight charges. 

Update Job 
Status 

If you want to change the Job Status (see page 15) of all jobs invoiced in this 
batch, select a new status here; otherwise, select <Don t Update> . 

Note: Only statuses that have the Jobs are complete characteristic 
ticked are available for selection here. 

Click the Create Invoices button to proceed. 

If you selected Let me apply charges to individual invoices , the Create Invoices button is 
replaced by a Continue Process button. Click this button to assign freight charges for each invoice 
using the following window: 

 
Enter an amount into the Freight column for each listed invoice (or leave the amount at 0.00). 
Once all charges are applied, click the Create Invoices button to proceed. 

When the Create Invoices button is clicked, the system generates all invoices, as well as assigning 
serial numbers and updating job statuses where relevant. You are given the option of printing 
some or all of the invoices. 
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Job Analysis 

The Analysis tab shows a pictorial view of the performance analysis of a job. It provides 
information about the profitability and status of a job and any sub jobs, drawn together on one 
special tab so that it can be restricted to management users only. All of this information can be 
derived from customised reports. 

The Analysis tab is a dashboard interface containing widgets that display job summary 
information. Select the Analysis tab: 

 
The right and left arrow buttons in the main toolbar allow you to switch from job to job. 

Note: As a dashboard interface, the Analysis tab can be fully customised - dashboard 
widgets can be added and removed to suit your needs. A blank Dashboard interface 
can also be added on a separate tab. By default, this Dashboard tab is disabled - you 
can turn it on by configuring the Hide tabs in Job management screen User-level 
profile setting (see page 33). 
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Documents 

The Documents tab of Job Management window allows job specifications, contracts, drawings, 
spreadsheets, project files and so on to be stored against a job/debtor. See the MYOB Exo 
Business online Help for instructions on using the Document Manager. 

 
The Documents tab toolbar offers a selection of buttons for creating, importing and exporting 
documents: 

Button Function 

 Document 
Manager 

Opens a search screen that allows searching of all documents in the 
database. 

 Create Letter Creates a letter (in RTF format) and pre-populates this with the 
customer address etc. On saving, you are prompted to store it in 
database. 

 Delete 
Document 

Deletes the document row currently highlighted in the grid. 

 Merge 
Document 

Requests a template file for a mail merge and allows creation of a mail 
merged output file. 

 Export File Exports the currently highlighted document file (that is stored in the 
database) to be exported to a standalone file on disk. 

 Import File Imports a standalone file into the database and creates a document 
manager entry. 
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When importing or creating a file for inclusion in the Document Manager, a window opens for the 
user to enter filing reference information. It also allows the entry to be a filing link to a document 
held separately on disk or to copy the document content into the database itself. 

Saving as a link will use minimal additional disk space but saving into the database may make 
retrieval on a WAN easier. 

History Notes 

History Notes are another form of documentation against a job. Unlike documents (see page 92) 
added to the Document Manager, a History Note only accommodates plain text and does not 
support rich text or images. 

 
The preview pane may be completely shown or hidden by clicking the Show Preview toolbar 
button. 

The test may be hidden but the message header retained by clicking the  icon in the message 
header band. 

  



MYOB Exo Business Job Costing 

95 

Click the New History Note button (  ) to create an entry or double click an existing entry to edit. 

 

Profile Settings 

The following User-level profiles affect the behaviour of the History Notes tab: 

• Allow delete of history notes (Default=True) - Uncheck to prevent deleting of history notes. 

• Date stamp on History notes can be selected (Default=True) - Uncheck to prevent the 
selection of date-time stamp on history notes, will always default to now . 

• History notes can be edited after saving (Default=True) - Uncheck to prevent retrospective 
editing of history notes once they are saved. 
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Billing Schedule Tab 

The Billing Schedule tab shows all invoices related to the job. This includes: 

• invoices created from the Invoices tab (see page 81) 
• credit notes on invoices 
• billing schedules created for the progress billing feature (see page 120) 

Invoices can also be entered into the grid manually. 

 

Crediting Job Invoices 

To generate a credit note for an invoice on the job, right-click and select Generate Credit Note. 
Credit notes for job-related invoices can also be generated from the Transactions tab on the 
relevant Debtor account - right-click on a job invoice and select Generate Credit for Job Invoice. 
Once generated, credit notes also appear on the Billing Schedule tab. 

Crediting a job invoice completely reverses the transaction, including all stock movements and 
allocations. Credited invoice lines appear on the Invoice tab (see page 81), where they can be 
cancelled or written off as required. 
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Activities 

The Activities tab displays all activities associated with the job.   

 
An activity can be a Task or an Appointment: 

• A Task is a to-do item that must be completed in a specified time frame. 

• An Appointment is an event scheduled for a specific time. 

Activities can also be accessed via the Activity Search widget, which can be added to the Job 
Costing business flow menu. 

Note: When using the Exo Business CRM module, activities can be synchronised with 
Microsoft Outlook. Tasks are converted to Outlook Tasks and Appointments are 
converted to Outlook Appointments. 
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Creating an Activity 

Click the New Activity toolbar button to create a new activity (this button is available on the 
Activities tab and the Details tab). Alternatively, right-click on the Task Scheduler calendar in the 
time slot that you want to create the activity in. 

The Activity Window 

 
This is the window for entering new activities; use the table below as a reference for completing 
the fields in this window. 

Field Description 

Activity Type Select whether the activity is a Task or an Appointment. 

Type This is a user-definable classification for the activity. Select a type from the 
list, or select Edit List...  to create a new type. 

Sync with 
Outlook 

If this box is ticked, the activity will be synchronised with Outlook whenever 
a sync is performed. If this box is not ticked, the activity will not be included 
in synchronisation operations. 

Subject Type a brief description of the activity and its purpose. 

Company 
Contact 

Assignment of an activity to a Company and/or Contact is optional. Where 
assigned, the activity will appear on the Activities tab of that company 
(Debtor, Creditor, Non Account) and/or the Contact screen. 

Note: When entering the Company name, use the search option by 
typing ? and pressing TAB. 
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Opportunity This field is only available when the Exo Business CRM module is licensed. 
Specify an Opportunity to associate the activity with. This field is optional. 

Label A label can be specified for the activity - this affects how it will appear on 
calender displays. 

Priority A priority (Low, Normal or High) can be specified for the activity. Low and 
High priority tasks are indicated with an icon on calendar displays. 

Status The Status setting has predefined list entries, but these may be edited or 
added to using the Edit List...  option. 

For Tasks, clicking the Mark Complete toolbar button automatically updates 
this property to Completed . 

Assigned To 
Assigned By 

The Exo Business Staff members that the activity was assigned to and by. 

% Complete This property applies to Tasks only. Specify the percentage completion by 
entering a number or using the arrow controls. 

Clicking the Mark Complete toolbar button automatically updates this 
property to 100%. 

Start Time 
End Time 

The start and end time for the activity. 

All day event If this is selected, the selections for the time of day will disappear as they 
are no longer valid. 

Reminder If you tick this checkbox, the system will pop up a reminder from the 
system tray after adding a reminder icon. Reminders can be enabled or 
disabled using the Enable Reminders option on the Tools menu of the 
Activity Search window/Dashboard widget. 

Show time as This property applies to Appointments only. Select how to display the time 
for this activity on the Task Scheduler. Choose from: 

• Free 

• Tentative 

• Busy 

• Out of Office 

Note: The relationship between the Status and % Complete properties is automatically 
maintained. For example, setting Status to Completed  automatically updates the % 
Complete value to 100  and vice versa. 

Once all properties are configured, click Save and Close on the toolbar to save your changes. 
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Activity Recurrence 

Click the Recurrence button to set an activity as recurring and establish the frequency. 

 
Configure the recurrence options and click OK to assign this to the new or edited task. If you are 
editing an existing task and no longer need this recurrence to continue, click Remove recurrence 
to remove this from the calendar. 
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Resource allocation allows resources such as staff and plant to be booked against a job. This can 
also generate appointments in the Microsoft Outlook calendar. 

Creating a Resource Allocation 

Resource allocations can be created in several ways: 

• Right-click on a job on the Job Overview tab (see page 54) of the Job Management screen 
and select Assign Resources. 

• Click the Resource Allocation button on the toolbar of the Details tab (see page 38) or 
Activities tab (see page 96). 

The Setup Job Resource Allocation window appears. 

 
Enter commitments for staff or plant, then click Save & Exit. 

You can see a graphical overview of all resource allocations on the Resource Overview (see page 
102) tab. 

Note: When allocating resources, the system checks for over-allocations and checks that 
the Start and End Dates fit within the dates for the job. If either check fails, you are 
presented with a warning message. Two profile settings, Resources - Check for 
Resource Over-Allocations and Resources - Synchronise Job and Resource Dates are 
available to enable/disable these checks. 

Note: If the job s Start and/or Due Date are changed, the resource allocation dates are 
automatically updated. 
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Creating Activities 

When a resource allocation is created, an Activity (see page 96) for the relevant staff member is 
automatically created in the Exo Business system. Activities can be viewed in the Activity Search 
widget, which is available on the main interface of both the Job Costing module and the Exo 
Business core. 

Note: If the resource is not associated with a staff member, the Activity will not appear on 
the Activity Search widget. It may be useful to set up a dummy staff account to 
associate non-staff Resources with. 

Integration with Microsoft Outlook 

Individual allocations can be sent to Microsoft Outlook as calendar appointments by clicking the 
Create Appointment button. The job description is used as the body of the message. 

Note: After an Outlook appointment has been created, changing an entry in Job Costing or 
in Microsoft Outlook will not update the other entry. 

Resource Overview 

The Resource Overview tab available on the Setup Job Resource Allocation window (see page 
101) and the Job Management screen (see page 51) provides a graphical representation of all 
resource allocations (see page 101) in the system. 

 
The tab is initially blank. To display resource allocations, select a time range from the Search on 
Resources Working control at the top of the tab and click Search. 

Note: The chart does not update automatically as job details are changed. To update the 
chart, you must click Search again. If the Show Resource Overview screen needs 
refresh warning User profile setting is enabled, a warning message alerts you when a 
job has changed. 
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The main section of the Resource Overview tab contains two areas: 

• An expanding list of all resource allocations matching the filtering criteria is displayed on 
the left. You can select a Show option to list only over-allocated resources, available (i.e. 
not over-allocated) resources or all resources. Click the plus or minus boxes next to a 
resource to expand or collapse the allocations underneath it. Double-click on a job s name 
to view the Setup Job Resource Allocation window for that job (see page 101). 

• A chart showing the resource allocations on a calendar display. Resource allocations are 
represented as coloured bars. Over-allocated resources are highlighted in red. Double-click 
on a bar to view the Setup Job Resource Allocation window (see page 101) for the job that 
relates to the bar. 

You can drag the divider between these two areas to give more or less room for each. 

Navigating the Chart 

Use the arrow buttons on the bar at the top of the chart to scroll it left and right 

To change the zoom level of the chart, click the   and  buttons on the toolbar, or drag the 
bar at the top of the chart left (zoom in) or right (zoom out). 

Click the  button to center the chart on the currently selected resource allocation, and expand it 
to fill the width of the display. 

Click the  button to print a copy of the chart as it currently appears onscreen. 
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About Serviceable Units 

Serviceable Units are an advanced feature of the Job Costing module. It is recommended that you 
consult with your Exo Business channel partner before implementing. 

Serviceable Units refer to items on which work may be required. These could be assets of the 
company running the Job Costing module or assets owned by their customers (perhaps 
previously sold to the customer). 

Serviceable Units can maintain a significant amount of information and history for the unit. To that 
extent they could be thought of as technically similar to Contacts but applying to asset items rather 
than people. 

A Serviceable Unit may optionally be associated with a stock item code and may even be 
associated with a serial number of that stock item. 

Serviceable Units may also have parent child relationships. 

Tip: When this Units feature is enabled, an extra Serviceable Units tab is available on the 
Debtors screen in the core Exo Business application. This tab lists any Serviceable 
Units relating to the Debtor account. 

Installing Serviceable Units 

Serviceable Units functionality is not installed by default. To add this functionality, a licence code 
for Serviceable Units must be acquired and installed. (The Serviceable Units feature does not have 
a separate executable; the functionality is included in the Job Costing module and the MYOB Exo 
Business core product when installed.) 

To install this licence: 

1. Open the MYOB Exo Business Configurator application and click the Add button on the 
Company > Registration section. 

2. Select Exo Serviceable Units  in the Module combobox and fill out the licence details 
supplied with your licence. 

3. Click Save. 

4. You now have to add the required additional tables and fields (metadata) to your 
database. To do this, click the Launch Update button. The Database Update window 
shows Exo Serviceable Units in the top grid. 

5. Click the Update button at the bottom of the screen to complete the task. 

Serviceable Units functionality is now available in the Job Costing module. 
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Configuring Serviceable Units 

Once the Serviceable Units feature has been installed, a Serviceable Units node becomes available 
in the Business Admin section of the MYOB Exo Business Configurator application. 

 
The sub-nodes under this node allow setup of a number of codes and descriptions for various 
properties that may be set for a serviceable unit. These include: 

• Unit Make 
• Unit Model (subsets of Unit Make) 
• Unit Class 
• Unit Usage Reading 

Tip: Makes, Models and Classes can be created from the Serviceable Units window if the 
Allow creation of new Make, Model and Class User-level profile setting is enabled. 

Serviceable Units can also be assigned one or more warranties. Set up warranties in the 
Configurator at Business Admin > Stock > Warranty. 

You can also set up the Job Costing menus to provide direct access to the Serviceable Units 
screen under the Accounts menu. This is done via the menu editor in the Configurator at Staff > 
Menus > Dropdown Menu. 
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Creating Serviceable Units 

You can a Serviceable Unit directly on the Job Management screen. This accommodates creating 
an entry for a unit when the first job for that unit is encountered, e.g. a new client brings their car 
in for servicing. If you have added the Serviceable Units option to your menu, you can create 
Serviceable Units independently of a job and then use them in a job at a later time e.g. selling a 
car and anticipating it being brought in for servicing. In either case the Serviceable Units screen is 
identical for both workflows. 

When the Serviceable Units feature is installed (see page 104), the Details tab (see page 38) on the 
Job Management screen shows an additional Serviceable Units sub-tab at the bottom of the 
screen. This allows pre-loading a list of units to be referenced on the job. New units may be 
created here or selected from the global list of units previously created (e.g. another service of a 
unit previously serviced). 

To create a serviceable unit, right click on the Serviceable Units sub-tab and select Create New 
Serviceable Unit. Alternatively, you can click the New button on the Serviceable Units window. 

The Serviceable Units window appears: 

 
Most of these fields are self-explanatory however some comments follow: 

• Serial # only applies if the stock item is serialised (see page 119). 

• Both the Customer and Service Agent can be chosen from a search window of companies 
(list contains both Debtors and Creditors). 

• Bill code refers to a Bill of Materials code (optional). 

A New Job button is available on this tab to create a new job (see page 38) from the Serviceable 
Units window. 

If the Allow creation of new Make, Model and Class User-level profile setting is enabled, a button 
is available on this tab to create Makes, Models and Classes from the Serviceable Units window. 
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Warranties 

Warranties are optionally added by right clicking in the warranties grid and selecting Insert 
Warranty. 

Parent Child Units 

Serviceable units can optionally be organised into parent-child relationships. More than one level 
of relationship is permitted. 

To establish a unit as being a child of another unit, specify the parent unit for the Parent Unit field. 

From any unit the parent child relationship tree can be viewed by clicking the  toolbar icon. 

 
The current unit will be highlighted in the tree. Any other unit may be drilled to (opens another 
instance of the Serviceable Units screen). 

Additional Tabs 

Once the required information on the Details tab is entered, additional tabs become available. 
Most of the additional tabs on the Serviceable Units window work in a similar way to their 
equivalents in the Debtors or Creditors account screens and are documented in the main MYOB 
Exo Business online Help. They are listed here with brief descriptions. 

Contacts 

The unit may have changed hands during its lifetime. The Contacts screen can be used to create a 
list of contacts associated with the unit, therefore the item is another entity that may form a role 
with each of these contacts. 

Contact History 

This tab displays history notes for the serviceable unit. This operates in similar fashion to Debtors 
accounts but the history is tagged to the unit. 

Serviceable History 

This tab displays any transactions that are associated with the unit. A New Job button is available 
on this tab to create a new job (see page 38) from the Serviceable Units window. 

Notepad 

Free-form text can be entered against the unit. 
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Schedules 

A maintenance schedule can be established on this tab. This can comprise multiple entries. 

Click New Schedule to add an entry or double-click an existing entry to edit it. 

Docs 

This tab allows the Document Manager function to link external documents to the unit. 

Using Serviceable Units in Jobs 

The list of serviceable units entered on the Details tab (see page 38) of the Job Management 
window forms a short list of units that may participate in the job. 

One of these units will be the default. The default may be changed by right-clicking another unit 
and selecting Set as Default. 

Pre-existing serviceable units may also be added to the job by right clicking in the grid and 
selecting Assign Serviceable Unit and then selecting from a search screen. A unit may be removed 
from the job by right clicking it and selecting Unassign Serviceable Unit. 

Assigning Job Lines to Serviceable Units 

When the Serviceable Units module is installed, you can use the Select visible columns function of 
the ExoGrids on the Timesheet, Costs, and invoice tabs to show a Serviceable Units column. 

To change the serviceable unit on a line, enter ?  in this column to select a Serviceable Unit from 
the short list entered in the job details tab. A search screen of these units appears. 

Note: Lines added to a job will automatically be tagged to the default serviceable unit listed 
for the job. It is therefore recommended that you construct the serviceable units list 
on the Details tab of the job before adding lines to the job. 
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A number of inbuilt reports exist in the Job Costing module. The Clarity library also contains 
additional reports and users may create additional ones using the Clarity designer. Your MYOB 
Exo Business trained professional will assist you in creating customised reports. 

The inbuilt reports and standard clarity reports are available under the Reports menu. 

Note: It may be necessary to edit the Reports menu at Staff > Menus in the Exo Business 
Configuration Assistant to make all of these reports available. 

Inbuilt Reports 

All inbuilt reports initially display to screen but may then be printed using the  toolbar button in 
the preview. 

Job Costing Report (see page 110) 
This report details all information recorded against a specific job, including any quotes. 

Job Status Report (see page 110) 
This report displays totals of estimates, time, materials and invoiced amounts recorded against 
each job meeting the criteria of the job statuses selected and a grand total for each. 

Work In Progress (see page 111) 
This report displays totals of estimates, time, materials and invoiced amounts recorded against all 
jobs.  From here specific jobs can be selected.  Also from this report direct access is available to 
Job Details and the Job Costing Report. 

Staff Time Report (see page 112) 
This report displays details of hours spent on all jobs, the hourly rate and the total sell price of 
labour for each job for a staff member during a specified period of time. From this display the 
direct access is available to the Job Costing Report. 

Already Invoiced Report (see page 113) 
This report displays principal information of invoices created relating to a job. The actual invoices 
generated for this job can be displayed from this screen. 

Master Details Report (see page 114) 
This report displays totals of estimates, time, materials and invoiced amounts recorded against all 
sub jobs for the selected master job. From this display direct access is available to the Job Costing 
Report. There is also a Clarity version of this report. 

Clarity Library Reports 

Job Analysis (JCTAnalysis.CLR) 
This report runs for one job at a time and gives the invoice & job summary as displayed on the 
Analysis tab in the Job management screen.  The report also lists the line level markup and margin 
details for the Quote, cost and time tabs. 

Job Status Report (JCHStatus.CLR) 
This report has lots of run time parameters available like job status, due date range, completion 
date range etc and is similar to the inbuilt report. The jobs are grouped by status and each job can 
be drilled down to view the transaction line details along with a summarised markup% and 
margin% by the line status. 

Work in Progress (JCHWIP.CLR) 
This report lists work in progress for all jobs. No parameters are required. The user can drill down 
on each job to view the transaction line details. 
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Labour/Resource Analysis Report (JCTLAbour.CLR) 
This is similar to the inbuilt staff time report but can optionally list all staff (resources) in one report. 

Job with Invoices/Charges (JCTAlreadyInvoiced.CLR) 
This is similar to the inbuilt Already Invoiced Report. The report lists all the jobs that have been 
invoiced and the user also has the provision to view the invoice details for the job. 

Job with No Invoices/Charges (JCHUninvoicedjobs.CLR) 
The report lists all the jobs which have no invoices/charges and gives basic details of the jobs like 
the job code, title, account, job manager, due date, customer order number, status, the current 
WIP amount and the Current WIP time amount. 

Job Transaction Report (JCTTrans.CLR) 
This report shows the job at a line detail level and a summary by cost group and cost type. 

Master Detail Report (JCHMaster.CLR) 
This report displays totals of estimates, time, materials and invoiced amounts recorded against all 
sub jobs for the selected master job. 

Job Costing Report (JCHCost.CLR) 
This report can be printed for an individual job or a combination list of job statuses can be 
specified. 

Purchases Listing by Jobs (JCHPurchases.CLR) 
The report lists the various purchases that exist per job. The purchases are categorized as 
invoiced, costed awaiting invoice, instore awaiting costing and ordered awaiting delivery. 

Job Cost Summary (JCHSummary.CLR) 
The report gives summarised information like the time, materials, invoiced value, job value, 
realised profit etc for the selected jobs. 

Job/Quote Comparison report (JCTComparison.CLR) 
The report has been developed to give a comparison between the quotes and the actuals. It 
displays the details of quotes and actuals for each job in terms of quantity, cost price and selling 
price. It gives the comparison between quotes and actuals, in terms of percentage variance (+/-) , 
for various cost groups and cost types in each job. It also has a summary at the end of the report, 
which combines data from all the jobs and gives the comparison between the quotes and actuals 
for the various cost  groups and cost types. 

Job Costing Report 

To generate the report, select Reports > Job Costing Report from the main Job Costing menu. 
The system displays a search screen of Job headers. Select the job you want to print or preview. 
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Job Status Report 

To generate the report, select Reports > Job Status Report from the main Job Costing menu. The 
following window is displayed: 

 
Select the criteria for the report by using the controls on this window. 

Click OK to generate the report or Cancel to cancel the report. 
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Work in Progress Report 

To generate the report, select Reports > Work In Progress from the main Job Costing menu. The 
following window is displayed: 

 
The list of jobs can be filtered by Job Status or staff member. 

When the Auto Refresh option is ticked, changes to the filters are applied instantly. If this option is 
not ticked, you must click Refresh to display the new selection after changing filters. 

Double-click on a job to see the job details (see page 38). 

Right-click on a job to view job details or print the Job Costing Report (see page 110). 

To print the report, select Print from the File menu. 

To save the report, select Save As from the File menu. Type an appropriate name for the file and 
click Save. 
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Staff Time Report 

To generate the report, from the Job Costing Main Menu: 

Select Reports > Inbuilt reports >  Staff Time Report.  The following screen is displayed: 

 
Select the Staff Name from the drop down box (Resource name). This can be a staff member or 
other resource (e.g. plant item) that you have set up. 

Select the start and end dates using the drop down calendars which display. 

Click OK. The system will show a list of jobs and the time for the selected resource. 

 
Tip: To display the Job Costing Report for a job double click on the line of the job. The 

report maybe displayed behind the Staff time report.  To bring to the front click 
anywhere on any part of the report that is visible 

To print the report, select Print from the File menu. 

To save the report, select Save As from the File menu. Type an appropriate name for the file and 
click Save. 
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Already Invoiced Report 

To generate the report, from the Job Costing Main Menu: 

Select Reports > Already Invoiced Report. The system will display a search screen of jobs. 
Highlight the job you want to print and click the Select and Close button to display the report. 

 
Double-click an invoice line to display the full invoice. 

Master Detail Report 

To generate the report, select Reports > Master Details Report from the main Job Costing menu. 
The system displays a search screen of Job headers. Highlight the job you wish to print and click 
the Select and Close button to display the report. 

Double click the Master Job to be displayed. 

 
Note: If the job selected is not a Master Job the error message No Data Found  will be 

displayed. 
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Double click on a job line to display the Job Costing Report for that line. 

To print the report, select Print from the File menu. 

To save the report, select Save As from the File menu. Type an appropriate name for the file and 
click Save. 

Clarity Business Forms 

Clarity Forms (CLFs) are identified with specific functions within the Job Costing module. These are 
essential business forms that are part of the usual business workflow. In contrast, Clarity Reports 
(CLRs) can be placed on the MYOB Exo Job Costing menu or run via the command line. 

Each of the main job forms can have a drop down list presenting a variety of formats. 

These are known as a form file lists  and are set up as comma-separated lists in the company 
profiles area of the Exo Business Configurator application. A good example is having several 
different options of quote layout available at printing time, e.g. detailed, brief etc. 

The following standard CLF files are available in Job Costing: 

Invoice.CLF 

The default Debtors Invoice form based on the DR_INVLINES and DR_TRANS tables. 

Will display Copy  if it detects that it has been printed previously. Often a job costing user will link 
additional job information to the debtors invoice 

JobPreview.CLF 

This form appears identical to Invoice.CLF, but the report itself is derived from Job Transactions 
and JOBCOST_HDR, as the DR_INVLINES and DR_TRANS entries have not yet been entered. Its 
purpose is to predict the appearance of the invoice before posting it to Debtors, allowing you to 
make alterations to the job. 

JobQuote.CLF 

Used to provide a printout of the job in a customer-oriented format. 

JobSheet.CLF 

Usually used as a sheet including work instructions and contact details for the job. 

Other Job Forms 

Form file lists allow you to create any number of job related business forms. Business examples 
might include Quality control sheets or a stock picking sheet. 
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Using Kits in Job Costing 

The Job Costing module can handle the inclusion of kitted items (Bills of Materials) in a job. Only 
Bills of Materials with the Type set to Kit  can be used in Job Costing - Build  and Order 
Template  Bills of Materials are not available for selection. 

Tip: See the MYOB Exo Business Help under Manufacturing  for full information on Bills of 
Materials. 

The benefits of this approach to kits are: 

• Kits can be moved as a complete unit from Quote tab to the Cost tab and Invoice tab. 

• A kit header line is displayed, which shows the cost and sell price of a kit within a job. 

• Components can be added to or removed from the kit after it is placed on the job and the 
cost and sell price will automatically be rolled up. 

• Kits can include non-default component options. These are lines that might represent 
optional variations to the kit. They are not added to the kit cost totals and are not added to 
the job unless selected afterwards.  

• Kit components can be serialised (see page 119). 

Note: Kits must be priced by component, with all component lines shown. The output item 
is a lookup code, and not a physical stock item. Hidden line price by total kits are not 
currently supported in Job Costing. 

Kit functionality is available in the Quote tab (see page 57), the Cost tab (see page 65) and the 
Invoice tab (see page 81) on the main Job Management screen. 

Adding a Kit to a Job 

You can select kits by entering a .  (full stop) in the Code column and pressing ENTER. This opens 
a list of active kits for you to select from. Bills of Materials of types Build  and Order Template  do 
not appear in the list. After selecting a kit, you are prompted for the quantity of kits that you 
require. 

 
Note: Decimal quantities can be entered if the Quantities value at Exo Business Config > 

Essential > General Settings > Decimal Places in Numeric Values is set to a value 
greater than zero. 

When inserting a kit, the system will draw its default components into the tab you are on. A kit 
header displays in bold. Its cost and sell price is calculated from the sum of its component lines, 
which have a shaded background. Any change to these component lines will result in a change 
rolling up to the kit header. The job totals are calculated on the sum of the component lines of kits 
together with normal non-component lines. 
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Note: Each kit has a unique number assigned to it when it is inserted onto a job. This is so 
that lines remain attached to their respective kit headers. Lines that are not part of a 
kit have the value -1. 

If the kit is priced by total, then after inserting the kit lines you will be asked to confirm the total 
price for the kit: 

 
The top option obtains its price from the Bill of Materials setup screen. This price is editable at run 
time and is apportioned across the kit lines (price rollup / rolldown). If the kit has an output code 
pointing at a stock item code, the system will test for the best price on that stock code and the 
result will be offered with the bottom option. This price is not editable but may be selected if 
desired. 

Note: The component lines of a kit may be hidden in the grid by ticking the Hide Kit 
Components checkbox. In this case, only the kit headers will show. 

Kit Options 

The following options can be accessed from the right-click menu on any kit line. 

Attach Line to Kit 

Right-clicking on a normal (i.e. non-kit) quote or cost line gives the option to attach that line to a 
kit. At least one kit must exist on the job before this function can be used. 

If you select this option, it will offer you a list of kits that exist on this job and if you choose to 
attach this line, then it will take on the kit ID of the kit chosen and the cost and sell prices for this 
line will add in to the kit totals. The line will be re-sequenced if necessary and added as the last 
line of the kit. 

Kit Functions 

When right-clicking on a kit header or one of its components, a different set of options relating to 
kits becomes available under the Kit sub-menu. 
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Change Copy To 

You can change the Copy to value on the entire kit or on single component line. If it appears that 
you can build a kit from the available stock on hand, you may choose to copy the entire kit straight 
to the cost tab when the quote becomes accepted and the job lines become activated. 
Alternatively, it may be necessary for one or more of the component lines to be purchased directly 
for the job. In this case, the Purchase Order line will remember the kit ID of the component being 
ordered, and when it is receipted and costed via inwards goods it will re-join the kit on the cost 
tab. 

Append Component Line 

This function allows the user to select additional lines from the Bill of Materials setup for addition 
to the kit. These are lines that have been marked as non-default and therefore were excluded 
when the kit was originally added to the job. These non-default BOM lines could be substitute 
items (used in conjunction with delete line of the original component) or common optional extras. 

Append Stock Item Line 

You can append a stock item line from the Stock file. Selecting this option displays the entire stock 
list in a search screen for selection. The item you choose does not have to be an item pre-
configured as optional in the Bill of Materials. 

Substitute Component Line 

This function is only available when right-clicking on a component line in a kit on the Costs tab. 
Selecting this option allows you to choose a new component item to replace the selected item. 

Extra Kit information 

This function allows you to enter additional information for the kit. A periscope-style window is 
displayed to allow serial number information to be entered if this kit will make an output item: 

 
This information is for record keeping and may be printed on customer reports - the serial does 
not exist in the main stock serials list. If an asset is produced for the job and this is a serialised (see 
page 119) item, the serial number must be added there manually. It also does not flow through to 
serviceable units (see page 104). 

Copy Bill Notes 

This function allows you to copy the notes established on the Bill of Materials setup screen into a 
narrative on the kit header line within the job. The narrative may then be customised as required 
and therefore the notes of the Bill of Materials may constitute a template. 

Duplicate Kit 

This function creates another instance of a kit already existing on a job, and is only available when 
right-clicking on the header line of a kit. Copying a kit is different from inserting a kit from the Bill 
of Materials setup, in that it will copy any customisations of the kit (such as added lines etc). 
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Tracking Serial Numbers 

About Serial Number Tracking 

The Job Costing module offers advanced serial number tracking features. This includes the ability 
to pre-assign serial numbers to work in progress prior to the invoicing stage, if your work in 
progress location is not zero and you are moving stock on entry to the job. Serialised lines can be 
copied from one job to another along with non-serialised lines by using the Copy button on the 
Quote and Cost tabs. 

To use these features, your work in progress stock location must be a valid stock location (i.e. not 
zero). 

The mode of serial tracking can be set on individual stock items. Job Costing supports tracking for 
Debtor Only (Out only), Creditor Only (In only) or Debtor and Creditor (In & Out Only). 

Note: Limited support is provided for Fully Tracked serials. For a serialised item tracked 
internally (including Fully Tracked), the system will prevent a line moving from the 
Quote tab unless a serial number is pre-assigned. Any mode that incorporates the 
Internal attribute can cause problems with the stock transfers to and from WIP unless 
the serial is known at all steps. The pre-assignment requirement means that the serial 
number must exist in stock before the Quote line can be sent to another tab. This 
particularly precludes creating a Purchase Order inside a job for such an item. 

To use these features you must enable two company-level profile settings in the MYOB Exo 
Business Configurator application: 

• Enable serial number tracking - This setting gives overall control over the enabling of serial 
number tracking features in all modules. 

• Allow serial number assignment - If this setting is not enabled, only the invoice production 
will prompt for serial numbers. 

Using expiry dates is optional. These can be used for Warranty or shelf life limits. 

Serial Numbers and the Quote Tab 

MYOB Exo Business has a profile setting that allows actual costs to be recorded on individual serial 
numbers of an item. This is not a form of FIFO stock but does record the cost that the serial was 
receipted to stock with. This can be useful for high value items where shipments vary significantly 
in cost. In such cases, when quoting, it may be desirable to know the individual serials cost in 
terms of negotiating a selling price. 

The Quote tab has the ability to display a Pref. Serial# (preferred serial number) column using the 
Select visible columns right-click menu option for the grid. This allows the operator to choose an 
existing serial that is in stock and not associated with another job. Enter the usual ?  to search in 
this column will display a list of serials that: 

• Are in stock 
• Are not pre-assigned to another transaction (e.g. Job, invoice or Sales order) 
• Have not been selected as a preferred serial in another job line 

Note: This third point makes this list different from just the unassigned serials that occur 
elsewhere in Exo Business products. Using a serial number in this indication of 
preference does not lock the serial number from being used elsewhere in the 
processing like pre-assignment does. 
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Serial Numbers and the Cost Tab 

If serial numbers are enabled and assignment is allowed, then whenever you save the job, the 
system detects if you have any have serial numbered items on the Cost tab (see page 73) that 
have not yet been assigned a serial number and it will give you the opportunity to assign 
them. This includes serialised items that have been copied from another job using the Copy 
button on the Cost tab. If you have already assigned the serial numbers but want to remove or re-
assign them you can call the Serial number assignment screen by clicking the Save and Prompt for 
Serial Numbers button (  ). 

Note: Serial number pre-assignment does not apply to lines that have not left the Quote 
tab (see page 119). 

Ultimately you will be forced to reconcile any outstanding serial numbers before you invoice these 
items. 

Serial Numbers and Purchase Orders 

If an item is tracked into store (Creditor) and goods are receipted into work in progress via inwards 
goods, the serial number will automatically be assigned to the job without need for further user 
intervention. 

If a job line containing a serialised item is cancelled (i.e. its Status is set to X ), then the serial 
number associated with it is automatically de-assigned and released back into the free serial 
number list. Cancelling the transaction moves the stock out of work in progress and puts it back 
into the default stock location. 

Progress Billing 

About Progress Billing 

Progress Billing is sometimes also known as contract invoicing. 

Note: This is an advanced feature. It is recommended that you consult with your MYOB 
Exo Business channel partner before implementing. 

Progress Billing allows a group of job cost lines to form a Billing Schedule entry. 

When Progress Billing is enabled, the Billing Schedule tab (see page 95) appears on the Job 
Management screen. 

Billing Schedules 

Progress Bills are charged through a lookup stock item whose code starts with the @  
character. One of these will have been automatically created in your database. 

Generating Billing Schedules 

A progress billing entry may be created in several ways: 

• On the Billing Schedule tab (see page 95), enter details directly into the grid. 
• On the Quote/Budget tab (see page 57), the Marked Lines submenu will have an option to 

Generate Billing Schedule. 
• On the Timesheets (see page 65), Costs (see page 73) and Invoice (see page 81) tabs, the 

Marked Lines submenu will have an option to Allocate to Progress Invoice. 
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From the Quote tab 

The Generate Billing Schedule function allows a schedule for billing to be created at the time of 
quote. 

1. On the Quote tab, mark some lines that have not been sent to another tab. 

2. On the right-click menu select Marked Lines > Generate Billing Schedule. 

3. A schedule window will appear for you to enter a description and due date (which is the 
date when the invoice is due to be created). The values are summed from the contributing 
lines and cannot be altered. 

 
4. Click OK. 

If you want additional schedules then you can repeat this for additional groups of marked lines. 

These schedules will now appear on the Billing Schedule tab. 

 
You can also create schedules manually on the Billing Schedule tab by pressing the down arrow 
on the grid and manually entering in a new schedule. You can specify the value manually or leave 
it at zero pending allocation of work in progress at a later time. 
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Adding Information 

Additional information can be added to the schedule by completing the following columns on the 
Billing Schedule tab: 

Field Description 

Due Date The anticipated date for creating a tax invoice. 

Allow Allocation Select Y  to allow work in progress lines to be allocated to the 
billing schedule. If N  is selected, the schedule will not appear on 
the Progress Invoice window for allocating lines. 

GL Code The General Ledger code the schedule is to be billed to. 

Note: The Enable display and override of GL code from stock 
item profile setting must be enabled for the GL code to 
flow through to the invoice; otherwise by default the 
invoice picks up the GL code for the stock item. 

Percentage Complete Enter a percentage to allow monitoring of progress of WIP relative 
to the schedule. 

Allocating Work in Progress Lines 

Work in progress lines on the Timesheets (see page 65), Costs (see page 73) and Invoice (see page 
81) tabs can also be allocated (added) to a billing schedule. Mark the required lines and from the 
right click menu select Marked Lines > Allocate to Progress Invoice. 

The system will prompt for the progress invoice to which the lines are to be added. 

 
  



MYOB Exo Business Job Costing 

123 

Click OK. The following window appears: 

 
This window lets you confirm which lines you want to add to the invoice. The top section of this 
window displays the lines that you selected on the Timesheets, Costs or Invoice tab; the bottom 
section displays the lines that are currently included on the selected invoice. Select the lines to add 
(by default, all lines are selected), then use the toolbar buttons to allocate them to the invoice. 

Invoicing Billing Schedules 

Pro-forma Invoices 

Pro-forma invoices may be generated from each of the scheduled bills. Highlight the schedule 
that you wish to action. The option to generate pro-form invoices is available in two places: 

• Select Progress Billing > Proforma Invoice from the toolbar on the Billing Schedule tab (see 
page 95). 

• Right click on a line on the Billing Schedule tab and select Proforma Invoice. 

The invoice will print, and a number will be allocated and shown in the Proforma Invoice column. 

Tax Invoices 

The Progress Billing dropdown and right-click menus also have options for creating a true tax 
invoice (Create Invoice). 

Note: Be sure to set the appropriate General Ledger code in the GL Code column before 
invoicing. 

Selecting this option opens the standard Exo Business Invoice Entry window. After invoicing, the 
invoice number will show in the Invoice No column and the background colour of the row will be 
green. The right-click menu now includes an option to View Invoice. 
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Retentions 

Retentions are an additional option that may be used to extend the functionality of progress 
invoices. Like Progress Billing, retentions are not activated in a standard Job Costing install and 
therefore associated properties do not appear by default. After consultation with your Exo 
Business channel partner, they will be able to activate this feature for you. 

Note: Retentions are not a standard supported feature. This feature has been designed in a 
very specific manner - care must be taken to ensure its suitability before 
implementation by the Exo Business channel partner. 

Retentions apply in some industries, such as the building industry, where the customer retains a 
certain portion of the bill to ensure that any follow up work required for merchantable quality is 
provided. From an accountant s perspective this can be a complex topic and advice is 
recommended before implementing this option. 

Default Retention Rates 

You will need to add the menu item Setup Retention Rates to the menu of your Job Costing main 
form via the menu editor in the MYOB Exo Business Configurator at Staff > Menus > Dropdown 
Menu. This will allow you to set the default retention levels for use in your database. 

Select this menu item to establish the base rates appropriate to your industry. 

 

Creating Retentions in the Billing Schedule 

When retentions are active, additional columns are available on the Billing Schedule tab and a 
Retention Levels button appears on the toolbar: 
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To set the retention values for a row, highlight the row and click the Retention Levels button. The 
Job Retention Levels window appears: 

 
Either click Set to Defaults to pick up the base rates established earlier or enter the default levels 
and rates manually. Click Apply. 

The retention rates and computed dollar amounts appear in the various Retention columns on the 
Billing Schedule tab. These columns are not editable, but may be reset using the Retention Levels 
button again. 

When the tax invoice is created for a row containing retentions, the retention value shows as a 
deduction on the invoice. This utilises a stock item with code RETENTION (this item is automatically 
created in your database). 

Realising a Retention 

Realising a retention means invoicing that retention. To realise a retention, right-click on the cell 
value of the retention you want to realise, then select Realise Retention. 

The Realise Retention window opens, allowing you to adjust the value you wish to invoice. 

 
Click OK. An Invoice window appears. 

Complete this in the normal manner. The cumulative retentions value will now appear in the 
Retention Realised column. Repeat the process when further retentions need to be realised. The 
value in the popup will default to the balance due. 
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Job Costing incorporates custom buttons that can call an executable file (a file which will run 
another portion of MYOB Exo Business) and pass it the connection name, user name, password 
and job number. This could be a Job Costing related program, or a special report such as a Clarity 
report. 

 
It is possible to define up to nine extra buttons each of which can execute external applications or 
run reports. Each button is defined by two properties: 

• The name or caption to appear on the button, or when the mouse pointer hovers over the 
button (limited to 15 characters). 

• The action to be performed. To run a Clarity report, only the report file name is required; 
otherwise normal parameters are passed automatically, i.e. <filename.exe> Aliasname  
Login  Password  Jobno parameter 

Custom buttons are set up using the MYOB Exo Business Configurator application, where they are 
configured as User-level profile settings (see page 33). 

Button Appears On Common Use 

1 Search Screen Job List (status) report 

2 Details Screen Single Job Summary Reports 

3 Details Screen Single Job Summary Reports 

4 Quote/Budget Screen Print Quotation 

5 Time Screen Single Job Time Sheet Summary 

6 Costs Screen Single Job Materials Summary 

7 Purchases Screen Purchase Lines report by Job 

8 Invoice Screen Invoice Preview 

9 Performance Screen Custom Performance summary 

Consult an Exo Business Partner for more information on settings these buttons. 
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How should I account for Stock on hand value and Work in Progress in my General Ledger? 

At this time, the only practical method of accounting for the value of stock contained in Work in 
Progress (WIP) is the periodic posting method. You then have a choice as to how physical stock is 
tracked within the system. 

You may nominate a selected stock location as WIP. As stock is used on the job, MYOB Exo 
Business will create a stock transfer from the selected stock location, to the nominated WIP 
location. Direct purchases will be inserted directly into the WIP Location. 

You can choose when the transfer of value actually takes place: at time of entry (recommended), 
or at time of invoice. 

One problem with tracking WIP as just another stock location is that sometimes you may never 
invoice the stock directly. It will never therefore be removed from the WIP location in the stock 
record. 

Another problem with this method is that you must remember to exclude the WIP location from 
your physical stock valuation. 

The true WIP value includes items that are non-physical such as labour and overheads. So looking 
at the value of physical stock in the WIP location can be misleading also. 

Sometimes it can be hard to ascertain the amount of free stock available because the WIP location 
is counted as free by default. By enabling the Exclude from Free Stock setting for the WIP 
location, you can exclude it from the free stock calculations. This setting is not suitable if you are 
using serialized items on jobs. 

Does Job Costing support a FIFO-style stock costing method? 

No, this method is not fully supported. 

Can I manually type into the Contacts field on the job, rather than setting up a Contact on the 
Debtors account? 

It is not possible to edit the Contacts field on a job header directly, as this is a lookup field to the 
table of Debtor Contacts. You can only add to or pick from the list of Contacts. We suggest that 
you enter text Contact references in the Our ref field, or the Notes sub-tab. 

Why can t I modify a transaction on the Costs or Timesheets tabs once it is Ready to Invoice ? 

Once a transaction has been transferred to the Invoice tab (see page 81), all alterations must be 
made to that transaction via the Invoice tab, or the transaction must be returned to the source tab 
by using right-click menu. The transaction is locked for editing if its status is R  - it must be 
returned the tab of origin before it can be modified. 

How can I speed up the entry of transactions? 

Use the default Cost Types (see page 22) by stock item as much as possible, as this speeds up 
entry. Select visible columns and the order of these columns on the transactions entry grids with 
care. 

Can I post Creditors Invoice lines directly to jobs without using Purchase Orders? 

It is possible to enter lines directly from Creditors Invoices to jobs; however you cannot assign Cost 
Types (see page 22) and Cost Groups (see page 20) at this time. The default Cost Type/Group will 
be assigned based on the stock item defaults. 
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Can I post Inwards Goods receipt lines directly to jobs? 

It is highly recommended that you receipt goods via the Inwards Goods process in MYOB Exo 
Business, as FX and landed costs are taken into account this way. This is a far more accurate 
method than simply receipting stock without any reference to the costs of getting the goods into 
store. 

Can I use line discounts and special price rules in Job Costing? 

Yes. Best price rules will apply in Job Costing unless they are disabled via the Best price and 
discounting in Job Costing company-level profile setting (see page 30). You can enable or disable 
the Discount column using the grid column controls by right-clicking on the transaction entry grid. 

The pricing policy for specific Debtors is applied to PRICE 1-N for the price number that that 
customer is associated with. 

Can I track stock batches and serial numbers via Job Costing? 

Batch number features are not enabled in Job Costing at present. 

Full pre-assignment of Debtor serial numbers (see page 119) is possible and multiple serial 
numbers can be applied to a single line. Not all serial number types are supported. There are 
issues with Fully Tracked serial numbers, as this places heavy restrictions on the ability to save 
stock transactions on a job before you know what the serial numbers are going to be. 

Can I have sell prices in Foreign Currency within a Job? 

Yes, this feature was added in the Exo Business 6.190 release. 

Can I use the New Purchase Order button on the Purchases tab to create multiple Purchase 
Orders without returning to the Purchases tab after each one? 

If you click the Purchase Order button on the Purchases tab (see page 79), this will automatically 
lock the job code in to the reference field as the default job code for each line. If you save this 
order and click New from the Purchase Order search screen, the job reference will be locked, but 
the job code will not be passed into it as default. Our recommendation is to use Purchase Orders 
off the main menu and enter the job code  or always go back to the job and click the Purchase 
Order button if you want to create multiple Purchase Orders for a job. 

Why do I keep getting the wrong job resource when I enter the initials on the timesheet? 

If you have two initials defined in the resource table that are the same, the system will always pick 
the first. 

Can I post to different Cost of Goods accounts in my GL depending on the type of transaction 
rather than the stock code used? 

It is not currently possible to post to Cost of Goods GL accounts from Cost Types in Job Costing. It 
is only possible to post via the Stock Item. This means that you cannot have profit statement by 
Job Type in the General Ledger, because all raw materials can be posted to only one Cost of 
Goods account. We recommend Job Profit reporting using Job Cost reports. 

How do I avoid variances in the Creditors Invoice cost after I have receipted stock onto a job? 

This problem should not occur if the Inwards Goods process is followed correctly, because the 
stock is not posted to the job until after it has been formally costed. 
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I have a written a report, and have found a lot of meaningless transactions on a Job 0 that I don t 
have. How did these get there and how do I clean them out? 

Previous versions of Job Costing posted all non-job-related Purchase Order lines to a non-existent 
Job 0. These lines were lines that were not posted to jobs. While they do not affect the system 
normally, they may appear as phantom lines in custom reports. These can be removed by 
executing the SQL scripts: 

DELETE from JOB_COST_LINES WHERE JOBNO = 0 

DELETE from JOB_TRANSACTIONS WHERE JOBNO = 0 

Can I use the One-off Stock Items features in Job Costing? 

One-off Stock Items cannot be created by pressing CTRL+O on job lines. To create a One-off 
Stock Item you must enter ?  and then choose the Copy Item button on the search screen. 

What are the Length, Width, Depth and Quantity fields for? 

These were written in for a specific industry group. The idea is that Length, Width Depth and 
Quantity are all 1 by default and therefore should have no effect unless they are enabled by 
making them visible and typing a quantity other than 1.00 into them. Another field, 
TOTAL_QUANTITY, exists on the job line to hold the sum of these volumetrics . This is a 
calculated field and cannot be edited by the user. It should be used for all calculations and reports. 
Normally users will only enter values into the Quantity field as this will always appear on reports 
and business documents. 

Job Costing volumetric measurements can also cater for fixed dimensions on stock items. 

If an extra field X_LENGTH is added to the stock item, the Length field in the Job Costing 
transaction will automatically be populated with this value. The default value of the extra field 
should be 1.00. 

If an X_WIDTH field is added to the stock item table, the Width field is populated with this value 
on entry. 

If an X_DEPTH field is added to the stock item table, the Depth field is populated with this value 
on entry. 

Examples might include standard stock lengths and widths for sheets of plasterboard or roofing 
irons where the resulting price on the transaction is by total square metre. 

How can I use the paste to grid functionality in the Quote tab? 

The Quote tab (see page 57) has the ability to accept lines pasted from a spreadsheet if the 
spreadsheet is in a compatible format, i.e. the columns are in the same order and values are 
compatible. 

Pasting of advanced kits is supported in a very comprehensive but very specific fashion, not as a 
generic feature. 

Can I add extra fields of my own design to Job Transaction lines? 

As in the rest of the MYOB Exo Business system, you can use the Extra Fields function to create 
and add database fields of your own design to a job header, and add all the necessary controls on 
the job details screen to allow you to input and maintain the information. However, Job Costing 
also allows you to do this with transaction lines. 

I am receiving the following error message saving a timesheet transaction: Hours on a timesheet 
cannot be zero.  What does this mean? 

When you enter a transaction into the timesheet and Job Costing has been configured such that 
you enter the number of time units manually (as opposed to start time and end times) then you 
must enter a value into this field before the transaction can be saved. 
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How is the sell price determined if I purchase goods directly for a job? 

Using the following process: 
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